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Bu öğrenme biriminde 
neler öğrenileceğini 

gösterir.

Konu başlığını 
gösterir.

Hazırlık Çalışmaları 
alanını gösterir.

Öğrenme biriminin 
adını gösterir.

Konu anlatımını 
gösterir.

Öğrenme biriminde yer 
alan konuları gösterir.

Öğrenme biriminin 
adını gösterir.

Öğrenme biriminin giriş 
kapağını adını gösterir.

Öğrenme biriminin
numarasını gösterir.

Öğrenme biriminde yer 
alan kavramları

gösterir.
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Uygulama alanını 
gösterir.

Etkinlik alanını 
gösterir.

Ölçme ve Değerlendirme 
alanını gösterir.





KONULAR
1.1.	 TAKVİM TASARIMI
1.2.	 KOLAJ VE MONTAJ İŞLEMLERİ
1.3.	 BİLGİSAYARDA TAKVİM OLUŞTURMA

NELER ÖĞRENECEKSİNİZ?
•	 Takvim çeşitleri ve özellikleri
•	 Takvim tasarımında dikkat edilecek hususlar
•	 Kolaj ve montaj araçları, bu araçların özellikleri ve 

dikkat edilecek hususlar
•	 Takvim tasarımı eskiz çalışması oluşturma
•	 Eskiz çalışmasını bilgisayara aktarma
•	 Bilgisayar ortamında gerekli programlarda takvim 

tasarımı oluşturma
•	 Takvim tasarımını baskıya hazır hâle getirme

TEMEL KAVRAMLAR
•  zaman                •  duvar takvimi    •  gemici takvimi 
•  piramit takvim     •  kolaj                 •  montaj
•  CTP                   •  kaplama
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Görsel 1.1: Duvar takvimi

1.1.TAKVİM TASARIMI
Endüstri Devrimi ile birlikte oluşan çağın yeni 
koşulları, toplumsal hayatı ve dolayısıyla gün-
delik yaşamı şekillendirmekteydi. Yaşamın 
hareketliliğini yakalamak adına zamanı prog-
ramlamak zorunlu hâle geldi. Bu durum, grafik 
tasarım ürünleri içinde önemli bir yere sahip 
promosyon materyali olan takvimi insanların 
vazgeçilmez araçlarından biri hâline getirdi.

1.1.1. Takvim
Zamanın yüzyıl, yıl, ay, hafta ve gün olarak 
parçalara bölünüp düzenli bir sırayla göste-
rildiği çizelgelere takvim denir. Takvim, kro-
nolojik bir zaman cetvelidir. Süreler, Güneş 
ve Ay döngüsü gibi astronomik olaylar ile 
suların yükselmesi ve çekilmesi gibi bazı 
doğal olaylar üzerinden belirlenir. 

Birçok uygarlık ve toplum özel ihtiyaçla-
rına uygun takvim modelleri geliştirmiştir. 
Dünyada en çok Hicri ve Miladi takvimler 
kullanılmaktadır. Hicri takvim, Ay’a göre ha-
zırlanmıştır ve Hz. Muhammed’in Mekke’den 
Medine’ye hicretini başlangıç olarak alır. 
Miladi takvim ise Güneş’e göre hazırlanmış-
tır ve Hz. İsa’nın doğumunu başlangıç ola-
rak alır.

1.1.2. Takvim Çeşitleri ve Özellikleri
İnsanların günlük yaşamlarında işlerini plan-
lamada yararlandığı takvimin kullanım amaç-
larına göre çeşitleri mevcuttur.

Duvar Takvimi: Kullanım sırasında konum-
landığı alanlar duvarlardır. Müşteri isteğine 
göre günlük (blok), aylık, üç aylık (4 yaprak) 
ve yıllık (poster) olarak tasarlanabilen tak-
vimlerdir (Görsel 1.1).

Hazırlık Çalışmaları

1.	 Sizce takvim hangi amaç için kullanılır?
2.	 Takvim bir ihtiyaç mıdır? Fikirlerinizi sınıf arkadaşlarınızla paylaşınız.
3.	 Takvimin bir grafik ürünü olduğunu düşünüyor musunuz? Neden?

Bilgi Kutusu
Promosyon; potansiyel müşterileri-
ne kendilerini tanıtmak, akılda yer 
etmek, ürünlerini pazarlamak ama-
cıyla firmaların kullandığı tanıtım 
aracıdır. 
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Görsel 1.2: Gemici takvimiGörsel 1.3: Masa takvimi (piramit takvim)

Görsel 1.4: Özel tasarım takvim

Gemici Takvimi: Promosyon ürünleri içinde 
en çok tercih edilen takvim çeşididir. Bir 
önceki, içinde bulunulan ve bir sonraki ay 
olmak üzere üç ayı birden görme imkânı sunar. 
Gemicilerin çok uzun yolculuklara çıkması 
gerekebildiğinden ulaşılacak limanlar planlı 
olmalıdır. Bu nedenle denizcilik firmaları gemici 
takvimi kullanmayı tercih eder.
Masa Takvimi (Piramit Takvim): Ofis ve 
evlerde masa üzerinde kullanılmak üzere 
çift taraflı olarak tasarlanan takvimlerdir. 
Takvim çeşitlerinde farklı ciltleme yöntemleri 
kullanılabildiği gibi masa takvimlerinde de  her 
iki yüzü birden gösterebilmek için genellikle 
spiral kullanılır (Görsel 1.3).

Özel Tasarım Takvim: Kullanım yeri, ölçüsü 
ve tasarımı müşteri isteğine göre değişkenlik 
gösteren takvim çeşididir.
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Multimedya Takvim: Bilgisayar, cep te-
lefonu ve tabletlerde var olan takvimler-
dir. Bazıları herhangi bir kurumsal bilgiye 
sahip değildir, sadece tipografik düzenle-
meden oluşur. Bazılarında ise kurumsal 
bilgiler mevcuttur (Görsel 1.5).

Görsel 1.5: Multimedya takvim

 
Görsel 1.6’daki takvim çeşitlerinin isimlerini verilen boşluklara yazınız.

Görsel 1.6: Takvim çeşitleri

1. Etkinlik

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
. . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



19

Ta
nı

tım
 G

ra
fi

ği

TAKVİM TASARIMI

1.1.3. Takvim Tasarımında Dikkat Edilmesi Gerekenler
Takvim, zamanı programlama işlevinin yanı sıra kurumsal bilgiler vererek tanıtım niteliği de ka-
zanmıştır. Tipografik ögelerin (sayı ve yazılar) tasarım ögesi olarak kullanılması ve tasarım ürün-
lerine yer verilerek akılda yer etmenin de kurumsal kimlik açısından etkili bir yöntem olması ile 
daha sanatsal takvim tasarımları yapılır hâle gelmiştir. Kurum ya da kişiler adına ürün ve hizmet-
lerin sergilenip hedef kitlelere ulaştırılmasında etkin rol oynayan takvim, basılı ve dijital reklam 
araçlarından birisidir. Bu bağlamda tasarım aşamasında dikkate alınması gereken birtakım öge-
ler mevcuttur. 

Takvimi oluşturan elemanlar; kurumsal bilgiler, iletişim bilgileri, görseller, hafta sayısı, gün sayısı, 
gün adları, tatil günleri, ait olduğu ay ve ait olduğu yıldır. Bu elemanların sayfa tasarımı ve tasarı 
ilkeleri açısından bütünle ve kendi içinde birbirleri ile uyumlu olması gerekir. Ayrıca takvimin kul-
lanılacağı konum doğrultusunda görünürlük, her açıdan göz önünde bulundurulmalıdır. 

Renk Seçimi: Tasarımda kullanılacak renkler, kurumsal renklerle uyum içinde ve estetik açıdan 
tamamlayıcı nitelikte olmalıdır. Renklere müşteri ile karar verilmelidir. Seçilen renk; görünürlük, 
algılanabilirlik, dikkat çekicilik ve tasarı ilkeleri göz önünde bulundurularak kullanılmalıdır.

Font Seçimi: Kuruma ait özel bir font varsa o kullanılmalıdır, yoksa kuruma uygun olan bir font 
seçilmelidir. Font seçiminde takvim çeşidi de göz önünde bulundurularak fontun okunaklı, anla-
şılır ve görülebilir olmasına dikkat edilmelidir. Yazılar, duvar ve gemici takvimlerinde görünürlük 
açısından daha büyük ölçülerde kullanılmalıdır. Masa takviminde ise daha küçük ölçülerde kul-
lanılabilir.

Görsel Seçimi: Müşteri isteğine göre sanat ve tasarım ile ilgili olabileceği gibi kurumsal tanıtım 
ile ilgili de olabilir. Bu görseller; fotoğraf, vektörel çizim ve grafiklerden oluşabilir. Seçilen görseller, 
duvar ve gemici takvimlerinde büyük ölçülerde; masa takviminde daha küçük ölçülerde kullanı-
labilir.

Basılacak Malzeme: Duvar, gemici ve masa takvimlerinde kalıp bölümleri (takvimin ciltlendiği 
kapak kısmı) kalın ve dayanıklı malzemelerden (400 g kroma karton) olmalıdır. İç yapraklardan 
oluşan ay bölümleri, ince formalardan (kuşe kâğıt) olabilir. 

Görsel 1.7: Kroma karton Görsel 1.8: Kuşe kâğıt



20

Ta
nı

tım
 G

ra
fi

ği
TAKVİM TASARIMI

1.1.4. Takvim Eskiz Çalışması
Eskiz çalışmasına başlamadan önce müşteri ile karar verilmesi ge-
reken bazı hususlar vardır. 

•	 Hangi çeşit takvim olacak?
•	 Kaç adet basılacak?
•	 Ne tür görseller kullanılacak?
•	 Hangi renkler kullanılacak? 
•	 Hangi font kullanılacak? 

Takvim çeşidi; takvimin ölçüsünü, ne tür malzemeyle yapılacağını 
ve içinde kullanılacak tasarım ögelerinin ölçü ve konumunu belir-
lemek için kullanılır. Takvim çeşidinden dolayı değişiklik gösteren 
basım malzemesi ve ölçü, aynı zamanda fiyatta da değişkenliğe 
sebep olur. İşin adeti ve fiyatı, teslim süresini ve baskı çeşidini be-
lirlemek için kullanılır. Ayrıca kurum yetkililerinden kurum bilgisi bö-
lümünde kullanılmak üzere firma logo, amblem, logotype zemininin 
transparan hâli temin edilmelidir.

Takvim Ölçü ve Malzemeleri 

Her ne kadar günümüzde standart ölçüler yerine özel ölçüler daha 
çok tercih edilse de müşteri aksini belirtmediği takdirde takvim ölçü 
ve malzemeleri aşağıdaki gibidir. 

Görsel 1.9: Takvim çeşitleri, ölçüleri ve malzemeleri

y

70 g 1. kalite hamur

y
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Oluşturulan eskiz çalışmalardan uygun olan bir tanesi seçilir, düzeltme gerekiyorsa yapılır, dijital 
ortama aktarılmak üzere çalışmaya son hâli verilir. 

Takvim tasarımını yapabileceğiniz hayalî ya da gerçek bir firma belirleyiniz. 
Aynı sektörde var olan firmaları araştırınız. Yapılan takvim tasarımlarını ince-
leyiniz. Yaptığınız araştırma, görüşme ve incelemeler ile aşağıdaki maddeler 
doğrultusunda hazırladığınız verileri bir dosya hâline getiriniz.

Görsel 1.10: Takvim çeşitleri eskiz çalışması

Takvim Eskizi Oluşturma

1. Firma adı

2. Firma bilgileri  

3. Diğer firma adları

4. Takvim örnekleri

5. Takvim çeşidi

6. Adet7.  Görsel türü

8. Renk / renkler

9. Font

2. Etkinlik



22

Ta
nı

tım
 G

ra
fi

ği
TAKVİM TASARIMI

ÖĞRENME BİRİMİ: TAKVİM TASARIMI
UYGULAMA ADI   : Takvim Eskizi Hazırlama
AMAÇ                    : Takvim tasarımı için gerekli ön hazırlıkları yapmak.

Araç Gereç
1. Bilgi dosyası
2. Eskiz sayfaları
3. Kalem, cetvel

Görsel 1.11’deki takvim eskizini inceleyiniz. Siz de belirlediğiniz firma için aşağı-
daki işlem basamaklarını dikkate alarak üç adet takvim eskizi hazırlayınız. 

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 

güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 2. Etkinlik’te hazırladığınız bilgi dosyanızı çıkarınız.
3.	 Dosyanızdaki bilgiler doğrultusunda eskiz çalışmanızı çiziniz.
4.	 Müşteriye alternatif çalışmalar sunabilmek için farklı versiyonlarda üç eskiz çalışma-

sı hazırlayınız.
5.	 Değerlendirme kriterlerini dikkate alarak üç eskiz çalışmasından bir tanesini öğret-

meniniz ile birlikte seçiniz.
6.	 Seçilen eskiz çalışmasında gerekiyorsa düzeltmeler yaparak eskize son hâlini veriniz.                                   

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, Ek 
1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

Görsel 1.11: Takvim eskiz çalışması

1. U
yg

ula
ma

Tipografik 
bilgiler alanı

Görsel
 alan

Kurumsal 
bilgiler
 alanı

Özel tasarım takvim
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Görsel 1.12: Dünyanın yedi harikası ve doğanın yedi harikası kolaj çalışmaları

1.2. KOLAJ, MONTAJ VE FORMA İŞLEMLERİ
Farklı malzemelerin bir yüzey üzerinde bir araya getirilmesiyle oluşturulan kompozisyona kolaj 
denir. Gazete kâğıdı, fotoğraf vb. nesneler yapıştırılarak gerekli durumlarda boya ile de müda-
hale edilerek uygulanır. Ayrıca dijital ortamlarda farklı fotoğrafların birleştirilmesiyle ya da tek bir 
fotoğrafın bölünmesiyle de uygulanabilen bir resimleme tekniğidir. Yazı ve rakamların yanı sıra 
görüntüler de tasarım ögesi olduğundan takvim tasarımında kolaj tekniği ile görüntü düzenlemek 
yerinde olur. Matbaacılıkta kullanılan temel hesaplama birimlerinden birisi olan ve sekiz ön, sekiz 
arka olmak üzere on altı sayfadan oluşan bölüme forma denir. Çoklu sayfa tasarımlarında çalış-
manın baskıya hazır hâlde kâğıda yerleştirilmesine montaj denir.

1.2.1. Kolaj ve Montaj İşleminde Kullanılan Araçlar ve Özellikleri
Kolaj işlemi, birçok program ile yapılabilir. Kullanılacak görüntünün fotoğraf olması durumunda 
piksel tabanlı görüntü düzenleme programı kullanılır. 
Kolaj ve montaj işlemi için kullanılacak araçlar, paneller ve komutlar şunlardır: 

•	 File > New (fayıl > niv) komutu ile özellikler verilerek yeni çalışma sayfası açılır. 
•	 File > Place (pileys) komutu ile görüntü ya da görüntüler sayfa içine direkt aktarılır ya 

da File > Open (opın) komutu ile görüntü, ayrı bir sayfa olarak açılır ve araç kutusundan 
Move Tool (muv tuul) ile taşıma yapılarak getirilebilir.

•	 Görüntülerin tamamı değil de belirli bölümleri kullanılacak ise seçme işlemi için seçim 
araçlarından Marquee Tool (marki tuul), Lasso Tool (laso tuul) kullanılabilir. Seçili alanı 
yeni bir katman olarak kopyalamak için Ctrl+J kısayol tuşu kullanılır.

•	 Çalışma sayfasını kesme (kırpma) ve artırma işlemi için Crop Tool (kırap tuul) kullanılır. 
•	 Görüntüye çerçeve eklemek için Layer (leyır) > Layer Style (sıtayl) > Stroke (sıtrok) ya 

da Layer paneli > Blending Options (bilending opşıns) komutu kullanılır.
•	 Görüntüye gölge vermek için Layer > Layer Style > Drop Shadows (dırap şadovs) ya 

da Layer paneli > Blending Options komutu kullanılır.
•	 Çalışma sayfasını kaydetmek için File > Save (seyv) komutu ya da Ctrl+S kısayol tuşu 

kullanılır. Çalışma kayıt türü PSD ve JPEG/TIFF formatı seçilerek kaydedilir. 
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1.2.2.  Kolaj ve Montaj İşlemlerinde Dikkat                 	
	 Edilecek Hususlar
Kolaj çalışmasının istenen amaca uygun, estetik ve 
göze hoş görünen nitelikte olması aşağıdaki özelliklere 
dikkat edilerek sağlanabilir.

•	 Konuya uygun görsel seçimi
•	 Görsel alan için ayrılan bölümün yatay ya da 

dikey olması, dolayısıyla sayfada kullanılmak 
istenen görsellerin yatay ya da dikey olması

•	 Görünürlük, netlik ve fark edilebilirlik açısın-
dan önemli olduğundan ayrılan bölümde kaç 
adet görsel kullanılacağı

•	 Görsellerin konum itibarıyla birbiri ile uyumu 
•	 Görsellerde çerçeve kullanılacaksa çerçeve-

nin sayfa ve görsel ile biçim ve renk uyumu
•	 Görseller arasında bırakılan espas değeri
•	 Görsellerin, sayfa ve birbirleriyle renk ve ışık 

uyumu gibi özellikler dikkate alınarak çalışıl-
ması; kolaj çalışmasının istenen amaca uy-
gun, estetik, göze hoş görünen nitelikte olma-
sını sağlar.

Mizanpaj işleminde ise özellikle çoklu sayfa tasarım-
larında baskı çeşidine (yan yana ya da alt alta) göre 
sayfa numarasının sıralanmasına dikkat edilmelidir.

Bilgi Kutusu
Çalışmanın kaliteli görünme-
si için kullanılan görsellerin 
yüksek çözünürlük değerle-
rine sahip olmasına dikkat 
edilmelidir.

Bilgi Kutusu
Bir çalışma, kullanılan progra-
mın kayıt türünde kaydedilirse 
daha sonra üzerinde düzen-
leme yapılabilir. 

3. Etkinlik

Daha önce eskiz çalışması olarak hazırladığınız takvim tasarımı için görsel-
ler araştırınız. Konunuza uygun görselleri belirleyiniz. Kolaj çalışmasında 
kullanmak üzere taşınabilir bellekte dosyalayınız.
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ÖĞRENME BİRİMİ: TAKVİM TASARIMI
UYGULAMA ADI   : Kolaj Çalışması 

AMAÇ                    : Takvim tasarımı için gerekli ön hazırlıkları yapmak.

Araç Gereç
1. Bilgisayar
2. Piksel tabanlı program
3. Görseller

Görsel 1.13’teki kolaj çalışmasını inceleyiniz. Siz de takvim tasarımında kulla-
nılmak üzere bir  kolaj çalışmasını aşağıdaki işlem basamaklarını dikkate alarak 
hazırlayınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı 
     ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Öğretmeninizle birlikte bir konu belirleyiniz, bu konu ile ilgili görselleri hazırlayınız.
3.	 Kolaj çalışması için piksel tabanlı programda uygun boyutlarda bir sayfa açınız.
4.	 Kolaj çalışmasında kullanmak üzere hazırladığınız görsellerden yeteri kada-
     rını çalışma sayfasına getiriniz.
5.	 Kolaj çalışması için piksel tabanlı programda gerekli araç, panel ve komutları
     kullanarak çalışmanızı yapınız.
6.	 Gerekiyorsa düzeltmeler yaparak çalışmanıza son hâlini veriniz.
7.	 Çalışmanızı program kayıt formatında ve JPEG formatında kaydediniz.                    

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, Ek 
1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

Görsel 1.13: Kolaj çalışması

2.
 U

yg
ula

ma
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1.2.3. Takvim Tasarımında Kolaj ve Montaj 
Takvim Tasarımında Kolaj: Başlıca özelliği zaman cetveli olan takvim, geçen zaman içinde sa-
nat ve tasarım ürününü sergileyen, grafik tasarım için bir yıllık sergilenme olanağı tanıyan bir 
grafik ürün niteliği kazanmıştır. Bu bağlamda takvim tasarımında tipografik ögelerin yanı sıra 
görseller büyük önem kazanmış, takvim görsel nitelikleriyle ön plana çıkmış ve tasarımın önemi 
gündeme gelmiştir. 

Oluşturulmak istenen takvim çeşidine göre (sergileneceği konum ve ölçü değişeceğinden) görsel 
alana uygun kolaj çalışması yapılmalıdır. Kolaj çalışmasında kendi içinde kompozisyon, tasarı ve 
sayfa tasarımı ilkeleri dikkate alınmalıdır. Ayrıca kolaj çalışmasının tipografik ögelerle de uyumu 
mutlaka göz önünde bulundurulmalıdır. Unutulmamalıdır ki takvim tasarımında ilk gösterilmek 
istenen tipografik ögelerdir.

Teknoloji ile ilgili görseller bularak Görsel 1.14’te sarı renk ile gösterilen gör-
sel alanın içine kolaj çalışması yapınız.

Görsel 1.14

4. Etkinlik
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Görsel 1.15: Sekiz sayfalık 
formalama işlemi

Bilgi Kutusu
Montaj işlemi için vektörel tabanlı 
program kullanılabilir fakat en ide-
al olanı çoklu sayfa tasarımlarında 
kullanılan ‘‘mizanpaj programı’’dır.

Takvim Tasarımında Montaj: Basılacak iş-
lerde baskıya hazırlık aşaması montaj işlemi-
dir. Çalışmanın toplam baskı adedine, baskı 
makinesi özelliklerine, ciltleme çeşidine, kul-
lanılmak istenen malzeme ve ölçüye göre dü-
zenleme yapılır. Kâğıt ölçüsüne göre tasarım 
çoğaltılarak yerleşim yapılır. Çalışmanın kâğıt 
üzerine yerleştirilme yönü önemlidir. Örneğin 
Görsel 1.15’teki gibi bir A4 kâğıt alınarak dörde 
katlanır, ilk sayfadan başlanarak sayfaların ön 
yüzünün sağ alt, arka yüzünün de sol alt köşe-
sine olmak üzere sayfalara arkalı önlü numara 
verilir. Açıldığında sayfa numaralarının yönüne 
göre tasarım yerleştirilir. Sayfada çalışmaların 
yüz yüze baktığı görülür.
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1.3. BİLGİSAYARDA TAKVİM OLUŞTURMA
Modern yaşam sonucu toplumsal hayatımız ve gündelik yaşantımızdaki gelişmeler, grafik sanat-
lar adına reklam ve tanıtımın öne çıkmasını sağlamış; tasarımların çoğaltılmasını zorunlu kılmış-
tır. Teknoloji ve dolayısıyla baskı tekniklerindeki gelişmeler sonucu artık tasarımlar, elde eskizler 
oluşturulduktan sonra bilgisayar ortamına aktarılmakta; programlar aracılığı ile gerekli düzenle-
meler yapılabilmekte ve baskı aşaması sonrasına kadar getirilebilmektedir.

1.3.1. Seçilen Eskiz Çalışmasını Dijital Ortama Aktarma
Oluşturulan eskiz çalışması, tarayıcı yardımı ile dijital ortama aktarılır. Görseller, piksel tabanlı 
programda; tipografik tasarım elemanları, vektörel tabanlı programda çalışılmak üzere düzenlenir 
(Görsel 1.16).
Piksel tabanlı programda aşağıdaki işlemler yapılabilir.

•	 Image (imıc) > Adjustments’ın (edcastmınts) alt seçenekleri olan Brightness/Contrast 
(bıraytnıs/kontrast), Levels (levıls), Curves (körvıs) seçenekleri ile grafiğin arka planı 
beyaz olacak şekilde düzenleme yapılabilir. 

Görsel 1.16: Takvim tasarımı çalışması

Bilgi Kutusu
Masaüstü Yayıncılık: Tasa-
rım ögelerini bilgisayar orta-
mında kullanarak baskıya uy-
gun tasarım oluşturma işidir.

5. Etkinlik
Görsel 1.15’teki gibi bir A4 kâğıt ile sekiz sayfalık formalama işlemi yapınız.
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1.3.2. Dijital Ortamda Takvim Tasarımı
Eskiz çalışması ve kurum için hazırlanmış bilgi dosyası doğrultusunda vektörel tabanlı 
programda File > New (CTRL+N) komutu ile yeni bir sayfanın genişlik, yükseklik ve taş-
ma payı gibi özellikleri düzenlenir. Sayfa içinde görsel alan, kurumsal bilgiler ve tipogra-
fik bilgiler için bölümler; programda gerekli araçlar ile ölçülendirme yapılarak düzenlenir. 
Sayfa içinde ölçülendirme yapabilmek için aşağıdaki işlemler yapılır.

•	 View (viu) > Rulers (rulırs) > Show Rulers komutu ile cetvel getirilir. Cetvel 
üzerinde sağ tuş yapılır  ve gelen pencereden çalışmada kullanılacak birim 
(cm, mm vb.) seçilir. 

•	 View > Guides (gayds) komutu ile yatayda ve dikeyde yardımcı çalışma çizgileri 
getirilir. Yardımcı çizgilerin sayfa içinde konumunun belirlenmesi için Properties 
(pırapırtiis) paneli kullanılır. Çizgilerin tamamını görünmez yapmak için View > 
Hide Guides (hayd gayds), çizgileri kilitlemek için View > Lock Guides (lak 
gayds), silmek için ise View > Clear Guides (kıliyır gayds) komutu kullanılır.

Sayfa içinde herhangi bir ögenin ölçülendirilmesi için Transform (tırensform) paneli, ko-
num düzenlemesi için Properties paneli kullanılır. Konum sıralaması için Layers paneli 
ya da sayfa içinde ölçülendirilmek istenen öge üzerine sağ tuş yapılarak açılan pence-
reden Arrange (erinç) komutu kullanılır. Ögeleri sayfada ve kendi içinde hizalamak için 
ise Align (elayn) paneli kullanılır. 

Görsel Alan Bölümü: Piksel tabanlı programda düzenlemesi yapılarak kaydedilen ça-
lışma, sayfa içine getirilerek ayrılmış bölüme yerleştirilir. Sayfada görsel alan için ayrılan 
bölümde vektörel bir çizim yapılması gerekiyorsa Pen Tool, Curvature Tool (körvicır 
tuul), Rectangle Tool (rektangıl tuul), Ellipse Tool (elips tuul), Polygon Tool (poligon 
tuul), Star Tool (sıtar tuul), Line Segment Tool (layn segmint tuul), Paintbrush Tool 
(peintbıraş tuul), Blob Brush Tool (bılab bıraş tuul) ve Pencil Tool gibi çizim araçların-
dan uygun olanlar kullanılabilir.

Kurumsal Bilgiler Bölümü: Önceden hazırlanan bilgi dosyası doğrultusunda, takvi-
min zemininde kullanılacak renklerin farklı veya çoklu renk olma ihtimali göz önünde 
bulundurularak firmanın logotype, logo ya da ambleminin transparan olmasına özellikle 
dikkat edilmelidir. Ayrıca takvimde iletişim bilgilerinin olmasının da reklamcılık açısından 
oldukça önemli olduğu unutulmamalıdır.

•	 Çizgi görünürlüğü için Filter (filtır) > Sharpen (şarpın)  > Smart Sharpen (sı-
mart şarpın)  komutu kullanılabilir.

•	 Marquee Tool, Lasso Tool ya da Pen Tool ile kesilip kullanılabilir. 

Grafiği dijital ortamda yeniden oluşturmak için grafik,  Pen Tool ile çizilir ve Paint (pe-
int), Bucket Tool (bakıt tuul), Gradient Tool (gıredıyınt tuul) ya da Brush Tool (bıraş 
tuul)  ile renklendirilebilir.
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İstenen genişlik değeri Width (vidt), yükseklik değeri Height (hayt) , satır (hafta) sayısı Rows (rous), 
sütun (gün) sayısı Columns (kalıms), aralarındaki mesafe ayarı Span (sipen), rakamların hangi 
aralıklarda ekleneceği Insert Spacing (insört sipeysin) ve hangi yönde (yukarıdan aşağıya / soldan 
sağa) sıralanacağı Text Flow (teks fılav) komutları ile uygulanır.

Yazı alanının sol üst bölümüne imleç konumlandırılır. İlk satırda günler, ikinci satırdan itibaren 
sayılar olacak şekilde her gün ve sayıdan sonra bir sonraki hücreye geçmek için Enter (entır) tuşu 
kullanılır. Önce günler, ardından 1’den 31’e kadar sayılar yazılır. Yazı puntosu küçük ya da büyük 
olduğunda istenen sonuç elde edilemez, punto alana göre belirlenmelidir. Gün isimlerinin yazıl-
dığı satır ayrıca oluşturulmak istenirse yine hücre geçişi için Enter kullanılarak haftanın günleri 
yazılır. Düzenleme için Window > Type > Tabs (tebs) ya da kısayol olarak Shift+Ctrl+T kullanılır 
(Görsel 1.18).

Görsel 1.18: Tabs paneli

Cetveli yazı alanına göre konumlandırmak için mıknatıs simgesine bir kez tıklamak yeterlidir. 
İlk hücrede imleç konumlandırılır ve Left-Justified-Tab (left-castifayd-tab) ile yazıların sola yas-
lanması sağlanır. Bu işlemin ardından her bir günü sola hizalamak için cetvel üzerinde istenen 
noktaya bir kez tıklamak yeterlidir.

Görsel 1.17: Area Type Options paneli

Width: Genişlik 

Height: Yükseklik

Rows: Satır

Columns: Sütun

Span: Hücre içi aralık

Fixed: Sabit

Gutter: Hücre dışı aralık

Insert Spacing: Ekleme aralığı

First Baseline: İlk taban çizgisi

Text Flow: Metin akışı

Tipografik Bilgiler Bölümü: Rectangle Tool ya da Type Tool (tayp tuul) ile aylara ait rakamların 
düzenlenebileceği bir alan oluşturulur. Alan, Rectangle Tool ile oluşturulmuş ise alanı yazı ala-
nına dönüştürmek için Type Tool ile alan çizgisi üzerine bir kez tıklamak yeterli olur. Yazı alanını 
düzenlemek için Type > Area Type Options (eriya tayp opşıns) paneli kullanılır (Görsel 1.17).

Area Type Options...
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Görsel 1.19: Masa takvimi çalışması

ÖĞRENME BİRİMİ: TAKVİM TASARIMI
UYGULAMA ADI   : Bilgisayarda Takvim Hazırlama
AMAÇ                    : Takvim tasarımı yapma.

Araç Gereç
1.0  Bilgisayar
2.0  Vektörel tabanlı program
3.0  Kolaj çalışması
4.0  Bilgi dosyası

Görsel 1.19’daki masa takvimi çalışmasını inceleyiniz. Siz de aşağıdaki işlem ba-
samaklarını dikkate alarak takvim tasarımını yapınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve güven-

liği tedbirlerini alarak özenle hazırlayınız.
2.	 Öğretmeninizle birlikte takvim tasarımı için bir konu  belirleyiniz. Belirlediğiniz konu 

ile ilgili kolaj çalışması yapınız.
3. 	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
4.	 Vektörel tabanlı programda yapmak istediğiniz takvim çeşidi ölçüsünde bir sayfa 

açınız.
5.	 Takvim tasarımı çeşidine göre sayfanızda gerekli alanların ölçülendirmesini uygun 

araç, panel ve komutları kullanarak yapınız.
6.	 Hazırlamış olduğunuz kolaj çalışmanızı sayfada gerekli alana konumlandırınız.
7.	 Kurumsal bilgiler ve tipografik bilgiler bölümlerini oluşturunuz. 
8.	 Gerekiyorsa düzeltmeler yaparak çalışmanıza son hâlini veriniz.
9.	 Çalışmanızı program kayıt formatında ve JPEG formatında kaydediniz.              

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, Ek 
1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

3. 
Uy

gu
lam

a
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1.3.3. Takvim Tasarımı Baskı İşlemleri
Bir grafik ürün; tasarım, film, kalıp çekme, baskı, baskı sonra-
sı olmak üzere beş aşamada gerçekleşir. Film ve kalıp çekme 
aşamaları ürün ofset baskı olacaksa uygulanır. Dijital baskıda 
bu aşamalara gerek yoktur. Baskı işlemleri, tasarımın oluşturul-
masından sonraki aşamalardır.
Tasarım: Araştırma ile başlar, eskiz ve ardından bilgisayar orta-
mında baskı aşamasına getirilir.
Film: Tasarımı oluşturulan çalışmanın baskı işleminde kullanıla-
cak kalıbını (Görsel 1.21’deki alüminyum plaka gibi) oluşturmak 
için film çıkışları alınır. Ardından baskıyı taklit eden yazıcılardan 
prova baskı alınır. 
Kalıp Çekme: Film çıkışından sonra kalıp üzerine tasarımın gö-
rüntüsünün çıkartılmasıdır. Filmin kullanılması ile pozlandırma 
ve banyo (kontakt baskı) işlemi, CTP [computer to plate (kom-
püdır tu pıleyt)] sistemi ile film ve montaj işlemlerine gerek olma-
dan yapılabilen işlem olmak üzere iki şekilde gerçekleşir.
Baskı: Ofset baskı, dijital baskı gibi farklı baskı çeşitleri bulunur. 
Grafik ürün çeşidine göre baskı farklılık gösterir. Tasarımın ilk 
oluşum aşamasından itibaren hangi baskı çeşidinin kullanılaca-
ğı ve yapılacak işlemlerin de bu seçime göre değişiklik göstere-
ceği göz önünde bulundurulmalıdır. 
Baskı Sonrası: Grafik ürünün çeşidine ve müşteri isteğine göre 
selefon, lak gibi malzemelerle yüzey kaplama işlemi yapılabilir. 
Çok sayfalı grafik ürünlerde katlama, harmanlama, iplik dikiş ya 
da tel dikiş gibi işlemler; ayrıca kitap ve dergi gibi ürünler için 
kapak takarak ciltleme gibi işlemler ve ambalaj gibi ürünler için 
ise kalıplı kesim gibi işlemler mücellithane makinaları kullanıla-
rak yapılabilir.

Görsel 1.20: Takvim tasarımı

Görsel 1.22: İki renkli ofset baskı makinası

Görsel 1.23:  Yüzey kaplama malze-
meleri (metalize, sedef, selefon)

Görsel 1.21: CTP
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Görsel 1.24: Takvim tasarımları

Takvim Tasarım Örnekleri
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Görsel 1.25: Takvim tasarımları
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Görsel 1.26: Takvim tasarımları
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Görsel 1.27: Takvim tasarımları
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Görsel 1.28: Özel takvim tasarımı

ÖĞRENME BİRİMİ: TAKVİM TASARIMI
UYGULAMA ADI   : Bilgisayarda Takvim Hazırlama
AMAÇ                    : Özel takvim tasarımı yapma.

Araç Gereç
1.0 Bilgisayar
2.0 Vektörel tabanlı program

Görsel 1.28’ü inceleyiniz. Siz de aşağıdaki işlem basamaklarını dikkate alarak özel 
takvim tasarımı yapınız. 

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve güvenliği 

tedbirlerini alarak özenle hazırlayınız.
2.	 Öğretmeninizle birlikte bir konu belirleyiniz, bu konu ile ilgili bilgi dosyası hazırlayınız.
3.	 Bilgi dosyası doğrultusunda eskiz çalışmaları hazırlayınız.
4.	 Öğretmeninizle birlikte eskizlerden bir tanesini seçiniz.
5.	 Yapmak istediğiniz takvim ölçüsünde vektörel tabanlı programda bir sayfa açınız.
6.	 Seçilen eskiz çalışması doğrultusunda gerekli araç, panel ve komutları kullanarak 

takvim tasarımını yapınız.
7.	 Gerekiyorsa düzeltmeler yaparak çalışmanıza son hâlini veriniz.
8.	 Çalışmanızı program kayıt formatında ve JPEG formatında kaydediniz.       

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, Ek 
1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

4. 
Uy

gu
lam

a
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ÖLÇME VE DEĞERLENDİRME 
A)   Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise   	
       “Y” yazınız. 
1.	 (    ) Takvim, zamanı programlamak için kullanılan bir grafik üründür. 
2.	 (    ) Gemici takvimi bir ayı gösterebilmek üzere tasarlanmıştır.  
3.	 (    ) Takvim tasarımında ölçü, müşteri isteğine göre değişiklik gösterebilir.
4.	 (    ) Montaj, çok sayfalı tasarımlarda çalışmanın baskıya hazır hâlde yerleştirilmesidir.
5.	 (    ) Tasarım ögelerini bilgisayar ortamında kullanarak baskıya uygun tasarım oluşturmaya 

masaüstü yayıncılık denir.

B)   Aşağıda verilen cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.
6.	 Müşteri isteğine göre günlük, aylık, üç aylık ve yıllık olarak tasarlanan takvim çeşidi 

…………………………takvimidir.
7.	 Takvim tasarımında yazı, sayılar ve ………………………… tasarım ögesidir.
8.	 Takvim tasarımında ilk gösterilmek istenen ………………………… ögelerdir.
9.	 Takvimin ………………………… fiyatını, teslim süresini ve baskı çeşidini belirlemek için gereklidir.

C)   Aşağıda verilen soruların doğru cevaplarını işaretleyiniz. 
10.	Aşağıdakilerden hangisi çoklu sayfa tasarımlarında çalışmanın baskıya hazır hâlde 

yerleştirilmesi işlemine verilen addır?
A)	 Baskı
B)	 Kırpma
C)	 Kolaj
D)	 Montaj
E)	 Perforaj

11.	 Aşağıdaki ciltleme çeşitlerinden hangisi özellikle masa takviminde her iki yüzeyi de 
gösterebilmek için kullanılır? 
A)	 Amerikan cilt
B)	 İplik dikiş
C)	 Omega tel dikiş
D)	 Spiral
E)	 Tel dikiş

12.	Aşağıdaki panellerden hangisi çalışma sayfasında yazı alanı düzenlemesi için kullanılır?
A) 0 Area Type Options
B) 0 Artboards
C) 0 Libraries
D) 0 Pathfinder
E) 0 Type on a Path
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13.	Aşağıdakilerden hangisi çalışma sayfasında ölçülendirme yapabilmek için kullanılan 
cetvel aracının kısayoludur? 
A) 0Shift+Ctrl+R
B) 0Shift+R
C) 0Ctrl+P
D) 0Ctrl+R
E)0 Ctrl+S

14.	Aşağıdakilerden hangisinde bir grafik ürününün beş aşaması doğru sıralamayla veril-
miştir?
A)	 Film, kalıp çekme, baskı, tasarım, baskı sonrası
B)	 Film, tasarım, kalıp çekme, baskı, baskı sonrası 
C)	 Tasarım, film, baskı, kalıp çekme, baskı sonrası 
D)	 Tasarım, film, kalıp çekme, baskı, baskı sonrası
E)	 Tasarım, kalıp çekme, baskı, film, baskı sonrası 

D)   Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.
15.	Takvim tasarımı yapılırken font seçiminde dikkat edilmesi gerekenler nelerdir?

………………………………………………………………………………………………………………

………………………….……………………………………………………………………………………

………………………………………………………………………..….………………………………..…

………………………………………………………………………..….………………………………..…

………………………………………………………………………..….………………………………..…

16.	Montaj işleminde hangi bilgilere göre düzenleme yapılır?

………………………………………………………………………………………………………………

………………………….…………………………………………………………………………………

…………………………………………………………………………………………………………..….

………………………………………………………………………..….………………………………..…

………………………………………………………………………..….………………………………..…





KONULAR
2.1.	 AFİŞ TASARIMI
2.2.	 BAŞKALAŞIM (MANİPÜLASYON)
2.3.	 BİLGİSAYARDA AFİŞ OLUŞTURMA

NELER ÖĞRENECEKSİNİZ?
•	 Afiş çeşitleri ve özellikleri 
•	 Afiş tasarımı için eskiz çalışmaları yapma 
•	 Piksel tabanlı programda fotoğraf başkalaştırma 

(manipülasyon) çalışmaları yapma
•	 Belirlenen afiş eskizini dijital ortama aktararak 

istenen sürede baskıya hazırlama

TEMEL KAVRAMLAR
•	 afiş
•	 başkalaşım (manipülasyon)
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2.1. AFİŞ TASARIMI
TDK Güncel Türkçe Sözlük’te “Bir şeyi duyurmak veya tanıtmak için hazırlanan, kalabalığın 
görebileceği yere asılmış, genellikle resimli duvar ilanı, ası.” şeklinde tanımlanan afiş, dilimize 
Fransızca “affiche” sözcüğünden türetilerek girmiştir.  Afişler; bilgi vermek, tanıtım yapmak gibi 
amaçlarla hazırlanan ve büyük kitlelere hitap eden grafik ürünleridir. Afişin genel işlevi, mesajını 
direkt ve hızlı bir şekilde izleyiciye yansıtmaktır. Günümüze kadar etkinliğini ve önemini korumuş-
tur. İnsanın olduğu her yere ulaşabilmesi, her sektörde ve her alanda uygulanabilir olmasının 
bunda etkisi büyüktür (Görsel 2.1). 

Hazırlık Çalışmaları

1.	 Afiş denince aklınıza gelenleri sınıf arkadaşlarınızla paylaşınız.
2.	 Daha önce gördüğünüz afişlerde neler dikkatinizi çekti?  

Görsel 2.1: Afiş örneği
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2.1.1. Afiş Çeşitleri ve Özellikleri
Grafik tasarım ögeleri içinde başta gelen 
afişin kullanım alanı oldukça geniştir. Kitap 
tanıtım afişinden doğum günü afişine, kon-
ser afişinden çikolata tanıtım afişine kadar 
uzanan geniş bir yelpazeye sahiptir. Buna 
rağmen mesaj ve içerik açısından afişler; 
reklam afişleri, kültürel afişler, sosyal afişler 
olmak üzere üç grupta toplanmıştır.

Reklam Afişleri 
Bir ürün ya da hizmeti halka tanıtmayı amaç-
layan afişlerdir. Halkı bilgilendirmek ve yön-
lendirmek için kullanılırlar. Tasarımı yapılan 
firma ya da ürüne göre çeşitlilik gösterirler 
(Görsel 2.2).

Görsel 2.2: a) Film afişi                          

 b) Gezi afişi                                                                                                       c) Ürün afişi
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Kültürel Afişler
Herhangi bir kültürel etkinlik veya ürün ile 
ilgili olan tasarımlar kültürel afiş kapsamı-
na girer. Sanat ve kültürle ilgili olan afişler-
dir. Konuları; sanat galerileri, kültürel olay-
lar, sergi, film, tiyatro, festival, müzik, spor, 
kitap, sinema, konser gibi (Görsel 2.3).

Görsel 2.3: a) Fotoğraf sergisi afişi       

b) Tiyatro afişi
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Sosyal Afişler
Toplumda farkındalık yaratmak, insan-
ların bazı konulara daha duyarlı yaklaş-
malarını sağlamak, toplum düzenini ko-
rumak gibi amaçlara yönelik hazırlanan 
afişler, sosyal afişlerdir (Görsel 2.4). 
Çevre, eğitim, politika, sağlık gibi konu 
başlıkları vardır.

Görsel 2.4: Sosyal afişler
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Tasarımın her alanında olduğu gibi afiş ta-
sarımı yaparken de tasarımcının müşteri ile 
fikir alışverişi yapıp konu ile ilgili önceliği be-
lirlemesi gerekir. Afişin amacı nedir? Bir ürün 
mü yoksa hizmet mi tanıtılacak (Görsel 2.5)? 
Hedef kitlesi kimdir? Hangi sosyal kesime 
hitap edecek? Hedef kitlenin yaş aralığı ne-
dir? Sosyal içerikli bir afiş mi olacak? Politik 
bir afiş mi olacak? Tasarımcı bu tarz sorular 
sormalı ve tasarımına bu soruların cevapları 
doğrultusunda başlamalıdır. 

Görsel 2.5: Tanıtım afişleri

2.1.2. Afiş Tasarımında Dikkat    	
	 Edilecek Hususlar
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Görsel 2.6: Dış mekân reklam panoları

Tasarımın amacı, hedef kitlesi vb. belirlendikten sonra afişin sergileneceği alan incelenmeli 
ve baskıda kullanılacak malzeme ona göre seçilmelidir. Afişler kullanılacağı alana göre iç 
mekân ve dış mekân olarak ikiye ayrılır, bu ayrım afişlerin tasarımında kullanılacak ögeleri 
(tipografi, görsel vb.) etkiler. İç mekân afişlerini inceleme süresi, dış mekân afişlerine göre 
daha uzundur. İnsanlar dış mekân afişlerini incelemek için uzun bir zaman ayıramadık-
larından dış mekân afişleri, mesajı en hızlı şekilde iletmek zorundadır. Tasarımcılar, afiş 
tasarımı yaparken bu kriteri göz önünde bulundurmalıdır.

Tasarım yapılırken ürün, hizmet ya da firmanın yeni olup olmadığı dikkate alınmalıdır. 
Tanınmış bir firmayla tanınmayan bir firmanın ürün tanıtım afişi aynı tasarım düzenine sa-
hip olamaz.  Tanınmış bir firmanın tasarımında ürün ön planda iken tanınmamış bir firmanın 
tasarımında firma ön plana alınır.

İnsanların dikkatini hemen çekecek bir slogan kullanılmalıdır. Özellikle dış mekânda sergi-
lenecek afişlerin mesajı iletme süresi çok kısadır. Slogan seçimi ürünü daha çarpıcı hâle 
getirir. 

Afiş tasarımının boyutları, afişin iç mekân ve dış mekân kullanımına göre seçilmelidir. Dış mekân-
da yazı ve görsellerin daha görülebilir, okunabilir olması ve mesajın çabuk fark edilmesi için büyük 
boyutlar tercih edilirken iç mekânda daha standart boyutlar kullanılabilir. Afiş için seçilen boyutları 
kullanım alanına göre değişiklik gösterse de genelde 35 x 50 cm, 50 x 70 cm, 70 x 100 cm tercih 
edilir.  Ayrıca afişler, kullanıldıkları yerlere ve ölçülerine göre farklı isimler alır (Görsel 2.6). 
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Afiş tasarımı yapılırken kullanılacak renkler de dikkatlice seçilmelidir. Ürün, hizmet ya da 
mesaja uygun renkler kullanılmalı ve renklerin insanlar üzerindeki psikolojik etkileri göz 
önünde tutulmalıdır. 

Yapılan tasarımda mesaj, ürün ya da hizmet merkeze alınmalı; dikkati dağıtacak başka ma-
teryaller kullanılmamalıdır. Tasarımın sadeliği algılama hızını olumlu etkiler. Vurgulanmak 
istenenler daha çabuk algılanır (Görsel 2.7).

Tasarımda kullanılacak tipografik ögeler yine afişin mesajına, hedef kitlesine ve amacına 
uygun olmalıdır. Yazı puntosu, afişin kullanılacağı mekâna göre seçilmeli; algıyı zorlaş-
tıracak fontlardan kaçınılmalıdır. Afişte verilecek mesaj yalın bir dille anlatılmalıdır. Afiş 
tasarımı yapılırken çok çeşitli tasarım elemanlarından faydalanılabilir. Tipografi, fotoğraf, 
illüstrasyon ya da farklı çizim teknikleri kullanılabilir.

Görsel 2.7: Sosyal afiş                                         
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2.1.3. Afiş Eskizi Hazırlama
Tasarımı yapılacak afişin içeriği, hedef kitlesi, 
sergileneceği alan ve afişle verilmek istenen 
mesaj doğrultusunda eskiz hazırlama çalışma-
larına başlanır. Bu çalışmalarda dikkat edilme-
si gereken önemli noktalar vardır.

•	 Çalışma yapılırken kullanılacak malze-
melerin ve çalışma ortamının temizliği-
ne dikkat edilmelidir.

•	 Afişi yapılacak ürün, firma ya da etkin-
liğin içeriği ile ilgili araştırma yapılmalı; 
bunların hangi alanda faaliyet yürüttü-
ğü, hangi hedef kitleye hitap ettiği belir-
lenmeli ve sonrasında tasarım kısmına 
geçilmelidir.

•	 Yapılan araştırma sonucunda hazırlana-
cak afişe uygun slogan belirlenmelidir. 

•	 Afişin ölçüsü, kullanılacağı iç ve dış 
mekâna göre ayarlanmalıdır. Tasarımda 
kullanılacak tipografik unsurlar buna 
göre ayarlanmalıdır.

•	 Afişte kullanılacak görsel materyaller 
belirlenmelidir.

•	 Afişte kullanılacak görsel, yazı, slogan 
vs.nin yerleşimi boş bir A4’e genel hat-
larıyla çizilmelidir (Görsel 2.8).

•	 Eskiz çiziminden sonra çalışma alanı 
temizlenmelidir.

•	 Yapılan eskiz bir dosyada saklanmalıdır.
•	 Tasarımda kullanacak görsel mater-

yallerin orijinalleri hazırlanmalıdır. Bu 
materyalleri tasarımcı oluşturmalıdır. 
İhtiyaç hâlinde fotoğrafı tasarımcı kendi 
çekmelidir.

•	 Materyaller (yazı, fotoğraf, vektörel çi-
zim vb.) bilgisayar ortamında oluşturu-
lacak bir klasörde toplanmalıdır.

Görsel 2.8: Afiş eskizi                                    
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Görsel 2.9: Sosyal afiş                                   

Görsel 2.9’daki afiş tasarımını inceleyerek afişin dikkat çeken yönleri-
ni aşağıdaki boşluklara yazınız.  Yazdıklarınızı sınıfta arkadaşlarınızla 
tartışınız.

1. Etkinlik

.........................................................................................................................................

.........................................................................................................................................

.........................................................................................................................................

.........................................................................................................................................

.........................................................................................................................................

.........................................................................................................................................
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Görsel 2.10: Konser afişi                                   

Şekil 2.1

Görsel 2.10’u inceleyiniz. Görseldeki tasarım ögelerini kullanarak Şekil 
2.1’in içine farklı bir afiş tasarımı eskizi çiziniz.

2. Etkinlik
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Afiş Tasarım Örnekleri

Görsel 2.11
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Görsel 2.12
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Görsel 2.13
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Görsel 2.14
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Görsel 2.15
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Görsel 2.16
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Görsel 2.17
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Görsel 2.18
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Görsel 2.19: Afiş eskizi                                     

ÖĞRENME BİRİMİ: AFİŞ TASARIMI
UYGULAMA ADI   : Afiş Tasarım Eskizleri Yapma
AMAÇ                    : Afiş tasarım eskizleri  hazırlamak.

Araç Gereç
1.	 A4 parşömen kâğıdı    
2.	 2H resim kalemi 
3.	 Silgi
4.	 Cetvel

Görsel 2.19’u inceleyiniz. Siz de seçtiğiniz bir konuda afiş tasarım eskizini aşağı-
daki işlem basamaklarını dikkate alarak yapınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve güvenliği 

tedbirlerini alarak özenle hazırlayınız.
2.	 Eskizini yapacağınız konu hakkında araştırma yapıp daha önceden yapılan afiş ta-

sarımlarını inceleyiniz.
3.	 A4 kâğıdına afiş tasarım eskizini  Görsel 2.19’daki gibi yapınız. Çizim yaparken kul-

lanılmış kâğıtların ya da işe yaramayan eski belgelerin arkalarını kullanabilir, böyle-
likle israftan kaçınmış olursunuz. 

4.	 Çalışma ortamını arkadaşlarınızla birlikte temizleyip çalışmanızı öğretmeninize tes-
lim ediniz.       

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, Ek 
1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

1. U
yg

ula
ma

Logo

Görsel alanı

Slogan

           Adres / Tel / Sosyal medya hesapları vb..
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2.2. BAŞKALAŞTIRMA (MANİPÜLASYON)  
Başkalaştırma, TDK’ye göre bir kütlenin fiziki ve kimyasal özelliklerinin değişmesi anlamına 
gelmektedir. Manipülasyon ise Türkçeye Fransızcadan girmiştir. Seçme, ekleme ve çıkar-
ma yoluyla bilgileri değiştirme, yönlendirme anlamlarını içermektedir.  

Grafik sanatlarda başkalaşım (manipülasyon) bir fotoğraf üzerinde yapılan en küçük deği-
şikliği bile kapsamaktadır. Orijinal olana her müdahale başkalaşımı doğurur. Başkalaşım, 
bir fotoğraf üzerinde yapılabileceği gibi farklı birkaç fotoğrafın birleştirilmesiyle de olabilir. 
Grafik tasarımcılar; başkalaşımı daha özgün fikirler ortaya çıkarmak, sıradanlıktan uzak-
laşmak ve hedef kitlenin dikkatini çekmek için sıklıkla kullanır. 

Başkalaştırma Yapılırken Kullanılan Araçlar 

Başkalaşım yapılırken piksel tabanlı programlar tercih edilir. Bu programlarda bulunan 
doku, renk, filtre, döndürme ve dönüştürme, maskeleme ve bazı temel rötuş araçları kulla-
nılır. Başkalaşım yapılırken Image > Adjustments yoluyla renk, kontrast vb. ayarlara ula-
şılabilir (Görsel 2.20). Ayrıca program menü çubuğunda bulunan Filter sekmesinden çeşitli 
hazır filtrelere; Tools’dan doku, rötuş araçlarına ulaşılabilir.

Başkalaşım yapılırken kullanılacak fotoğraflarda ışık uyumları, perspektif uyumları, doku 
uyumları, piksel ve çözünürlük uyumları birbirlerine denk olmalıdır. Ortaya çıkan yeni ürü-
nün kalitesi ve başarısı fotoğrafların uyumuna bağlıdır. Başkalaşım yapılırken dikkat edil-
mesi gereken belli başlı kurallar vardır.

•	 Kullanılacak fotoğraflarda dekupe işlemi titizlikle yapılmalıdır.
•	 Gerçekçi bir görünüm için gerçekçi ışık ve gölge kullanılmalıdır.
•	 Kullanılacak fotoğrafların dokularına, perspektifine, oran ve renk uyumlarına dik-

kat edilmelidir.

Görsel 2.20: Adjustments paneli
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2.2.1. Başkalaştırma (Manipülasyon) Yöntemleri
Başkalaşım yapılırken renk ve dokuya müdahale edildiği gibi büyültme, küçültme vb. ayar-
lar da yapılır. Piksel tabanlı görüntü işleme programının sağladığı olanaklar kullanılır. 
Başkalaşım yapılırken kullanılan belli başlı yöntemler vardır.

Boyutlandırma ve Dönüştürme İşlemleri: Fotoğrafların boyutları ve perspektif ayarları 
yapılırken kullanılan bir yöntemdir (Görsel 2.21).

Renge Müdahale Etme: Fotoğrafların tonlarını eşitlemek, 
renklerini değiştirmek gibi işlemlerle başkalaşım daha 
gerçekçi ya da daha fantastik hâle getirilir (Görsel 2.23).

Dokuya Müdahale Etme: Doku taşıma, yeni doku oluş-
turma gibi işlemlerle fotoğrafa fantastik bir görünüm ka-
zandırılabilir (Görsel 2.22).

Görsel 2.21: Boyutlandırma

Görsel 2.23: Renk değiştirmeGörsel 2.22: Dokuya müdahale
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Filtrelerle Müdahale: Fotoğraflara programda bulunan hazır filtre efektlerini uygulamaktır. 
Fotoğrafta farklı atmosfer yaratmaya yardımcı olur (Görsel 2.24).

Maskeleme: Fotoğrafların çalışma açısından gereksiz olan alanları maskelenir, bu alanla-
rın görünmemesi sağlanır (Görsel 2.25).

Görsel 2.24: Efekt verme

Görsel 2.25: Maskeleme

Propertles

Masks

Densty:

Feather:

Refine:
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2.2.2. Başkalaştırma (Manipülasyon) Örnekleri

1. Etkinlik

2. Etkinlik

Belirlediğiniz bir hayvan fotoğrafında hayvanın göz rengini değiştiri-
niz.  Yaptığınız çalışmanın çıktısını alıp öğretmeninizle ve arkadaşları-
nızla paylaşınız. 

Belirlediğiniz bir manzara fotoğrafında istediğiniz bir nesnenin doku-
sunu değiştiriniz. Yaptığınız çalışmanın çıktısını alıp öğretmeninizle ve 
arkadaşlarınızla paylaşınız.

Görsel 2.26
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Görsel 2.27
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Görsel 2.28

Görsel 2.29
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Görsel 2.30

Görsel 2.31



68

Ta
nı

tım
 G

ra
fi

ği
AFİŞ TASARIMI

Görsel 2.32

Görsel 2.33

Görsel 2.34
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Görsel 2.35

Görsel 2.36 Görsel 2.37

Görsel 2.38
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Görsel 2.39

Görsel 2.41

Görsel 2.40
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Görsel 2.42

Başkalaştırma Yöntemi İle Afiş Örnekleri
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Görsel 2.43
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Görsel 2.44: Başkalaştırma örneği

ÖĞRENME BİRİMİ: AFİŞ TASARIMI
UYGULAMA ADI   : Başkalaştırma (Manipülasyon)
AMAÇ                    : Başkalaştırma (manipülasyon) yapmak.

Araç Gereç

1.	 İşlem yapılacak görsel
2.	 Bilgisayar
3.   Görüntü düzenleme 
	 programı

Görsel 2.44’teki çalışmayı inceleyiniz. Siz de seçtiğiniz bir görsel üzerinde 
aşağıdaki işlem basamaklarını dikkate alarak başkalaşım çalışması yapınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 

güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Başkalaşım yapacağınız konu hakkında araştırma yapıp daha önceden yapı-

lan başkalaşım tasarımlarını inceleyiniz.
3.	 Başkalaşım yapacağınız çeşitli görseller bulunuz.  
4.	 Başkalaşım yapacağınız görseli açıp, istediğiniz değişiklikleri yaparak çalış-

manızı bitiriniz. 
5.	 Çalışmanızı piksel tabanlı program formatında (PSD) ve baskıya uygun for-

matta (TİFF / JPG) kaydediniz.
6.	 Çalışmanızı haricî belleğe kaydediniz.
7.	 İşiniz bittiğinde çalışmanızın çıktısını alarak öğretmeniniz ve arkadaşlarınızla 

paylaşınız.
8.	 Bilgisayarınızı kapatınız. Çalışma ortamınızı arkadaşlarınızla temizleyip dü-

zenleyiniz.     

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, Ek 
1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

2.
 U

yg
ula

ma
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2.3. BİLGİSAYARDA AFİŞ OLUŞTURMA
Yapılan her tasarımda olduğu gibi afiş tasarımında 
da ilk aşama eskiz yapmaktır.  Yapılan eskizlerden 
en uygun olan seçilerek gerekli materyaller bilgisa-
yarda oluşturulan bir klasörde toplanır. Çalışma ya-
pılırken çalışılacak konuya ve yapılacak işleme göre 
hem vektör tabanlı hem de piksel tabanlı program 
kullanılır. 

Afiş tasarımına başlanırken öncelikle çalışma için 
seçilen eskiz doğrultusunda piksel tabanlı program 
açılmalıdır. File > New (Ctrl+N) ile afişin ölçüsüne 
göre çalışma sayfası açılır. File > Place ile çalışma 
sayfasına işlem yapılacak fotoğraf aktarılır (Görsel 
2.45).

Görsel 2.45: Çalışma sayfasına 
fotoğraf çağırma                                                                                                        

Görsel 2.46: Afiş yapım aşaması

Çalışmada başkalaşım için kullanı-
lacak alanlar, diğer fotoğraflardan 
temizlenerek ana çalışma sayfasına 
getirilir (Görsel 2.46). Kullanılacak 
tüm görsel parçaları aynı çalışma 
sayfasına alındıktan sonra ışık, renk, 
perspektif vb. ayarlar yapılarak baş-
kalaşım tamamlanır.

Afiş çalışmasında kullanılacak fontlar, yine çalışmanın 
içeriğine göre seçilip yerleştirilir (Görsel 2.47). Afiş ça-
lışmalarında fazla font çeşidi kullanılmamalı, yazıların 
okunaklı olmasına özen gösterilmelidir.

Görsel 2.47: Font seçimi  
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Yazıya istenen efektler verilir, düzenlemeler yapılır. Sonra diğer yazılar (adres, tarih vb.), kullanı-
lacak logolar yerlerine yerleştirilerek çalışma sonlandırılır (Görsel 2.48).

Yapılan afiş çalışması son hâlini aldık-
tan sonra baskı ayarları yapılır ve baskı 
formatında kaydedilir (Görsel 2.49). Son 
anda oluşabilecek değişiklikler için çalış-
manın orijinal dosyası saklanmalıdır. 

Görsel 2.48: Afiş yapım aşaması    

Görsel 2.49: Çocuk tiyatrosu afişi    
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Görsel 2.50: Fuar afişi

ÖĞRENME BİRİMİ: AFİŞ TASARIMI
UYGULAMA ADI   : Bilgisayarda Afiş Oluşturma
AMAÇ                    : Bilgisayarda afiş yapmak.

Araç Gereç
1.	 A4 parşömen kâğıdı    
2.	 2H resim kalemi 
3.	 Silgi
4.	 Cetvel
5.	 Bilgisayar
6. 	 Görüntü düzenleme programı

Görsel 2.50’deki çalışmayı inceleyiniz. Siz de seçtiğiniz bir konuda aşağıdaki 
işlem basamaklarını dikkate alarak afiş çalışması yapınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 

güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Afiş yapacağınız konu hakkında araştırma yapıp daha önceden yapılan afiş 

tasarımlarını inceleyiniz.   
3.	 Farklı eskizler yapınız. Uygun olan eskizi seçip çalışmaya başlayınız.
4.	 Çalışma yapacağınız piksel ya da vektör tabanlı programı açınız.
5.	 Afiş için seçtiğiniz eskize göre çalışmanızı bilgisayar ortamında yapınız.
6.	 Çalışmanızı piksel tabanlı program formatında (PSD) ve baskıya uygun for-

matta (TİFF / JPG) kaydediniz.
7.	 Çalışmanızın çıktısını alıp öğretmeninize teslim ediniz.
8.	 Çalışma ortamını arkadaşlarınızla birlikte temizleyiniz. 

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, Ek 
1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere göre değerlen-
dirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

3. 
Uy

gu
lam

a
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ÖLÇME VE DEĞERLENDİRME 
A)  Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise 

“Y” yazınız.
1.	 (    ) Afişler,  bilgi vermeyi ve büyük kitlelere tanıtım yapmayı amaçlayan çalışmalardır.
2.	 (    ) Afişlerde sadece tipografik unsurlar kullanılmalıdır.
3.	 (    ) Afiş tasarımı için hedef kitlenin özellikleri dikkate alınmaz.
4.	 (    ) Afişlerde farklı ölçüler kullanılabilir.
5.	 (    ) Afişler sadece piksel tabanlı programlarda hazırlanır.

B)   Aşağıda verilen cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.
6.	 Başkalaşım ………………………  programlarında yapılır.
7.	 Afişlerde …….……………… mekâna göre değişir.
8.	 Ürün ya da hizmeti tanıtmayı amaçlayan afişlere………………………denir.
9.	 Afiş tasarımını bilgisayar ortamına aktarmadan önce ……………………… yapılmalıdır.
10.	Afiş tasarımlarında konuya göre farklı ………..……………… kullanılabilir.

C)   Aşağıda verilen soruların doğru cevaplarını işaretleyiniz.  
11.	 Aşağıdakilerden hangisi başkalaşım yöntemlerinden değildir?

A)	 Boyutlandırma
B)	 Doku
C)	 Filtre
D)	 Işık
E)	 Maskeleme

12.	 Manipülasyon uygulamasını açıklayan terim aşağıdakilerden hangisidir? 
A)	 Başkalaşım
B)	 Değiştirme
C)	 Düzenleme
D)	 Kopyalama
E)	 Kesme

D)   Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız. 
13.	Sosyal afiş tasarımı ile reklam afiş tasarımı arasındaki farklar nelerdir? Kısaca açıkla-

yınız.
	 ……………………………………………………………………………………………………

…………………………………….……………………………………………………………
………………………………………………………………………………………………..…

14.	Grafik tasarımda başkalaşım hangi amaçlarla yapılır? Kısaca açıklayınız.
	 ……………………………………………………………………………………………………

…………………………………….……………………………………………………………
……………………………………………………………………………………………….…





KONULAR
3.1.	 ETİKET TASARIMI ESKİZİ
3.2.	 BİLGİSAYARDA ETİKET OLUŞTURMA

NELER ÖĞRENECEKSİNİZ?
•	 Etiketin tanımı, çeşitleri ve etiket tasarımında 

dikkat edilmesi gereken hususlar
•	 Ürün özelliğine göre etiket tasarımı için eskiz 

çalışması yapma
•	 Belirlenen etiket eskizini sayısal (dijital) ortama 

aktararak istenen sürede baskıya hazırlama

TEMEL KAVRAMLAR
•	 eskiz
•	 renk
•	 baskı teknikleri
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3.1. ETİKET TASARIMI ESKİZİ 
Etiket; ait olduğu ürünün fiyatı, üretim ve son 
kullanım tarihi, kullanım koşulları, firma iletişim 
bilgileri, firmanın logosu gibi birçok bilginin oldu-
ğu basılı bir materyaldir. Birbirinden farklı alanla-
ra sahip olan etiketlerin günümüzdeki en önemli 
görevi, market raflarında müşteri bekleyen ürün-
lerin rakip firmalardan ayrılarak dikkat çekmesini 
sağlamaktır. Ürün tanıtımında oldukça etkili bir 
araç olan etiketlerin aynı zamanda marka değe-
rini artırma yönünde de bir etkisi vardır. Her sek-
törün kendine ait etiket tasarımı vardır.

Kullanım alanlarına göre günümüzde en çok 
tercih edilen etiket türleri; ürün etiketleri, yı-
kama talimatları, fiyat etiketleri, marka etiket-
leri, uyarı etiketleri ve barkod etiketlerdir.

Hazırlık Çalışmaları
1.	 Etiket denince aklınıza neler geliyor? Tartışınız.
2.	 Sizce etiketin kullanım amacı nedir? Düşüncelerinizi arkadaşlarınızla 

paylaşınız.

Bilgi Kutusu
Ürün veya hizmetin hedef kitleye 
istenen şekilde ulaştırılmasını sağ-
layan en önemli süreç tanıtım ve 
reklamdır.

Görsel 3.1: Etiket örnekleri



81

Ta
nı

tım
 G

ra
fi

ği

ETİKET TASARIMI

Ürün Etiketleri: Ürünün kullanım biçimi-
ni, özelliklerini, ağırlığını, üretim amacını, 
markasını gösteren ve tüketiciyi bilgilen-
dirmek amacıyla üretilmiş etiket türüdür 
(Görsel 3.2). 

Yıkama Etiketleri: Tekstil ürünlerinde rast-
lanılan bu etiketler, ürünlerin yıpranmadan 
doğru bir şekilde nasıl yıkanması gerektiği 
konusunda detaylı bilgiler veren etiket türüdür 
(Görsel 3.3).

Fiyat Etiketleri: Bir ürünün miktarı, türü, 
fiyatı gibi bilgilerin olduğu etiket türüdür 
(Görsel 3.4).

Marka Etiketleri: Ürün ya da ambalajın üze-
rine konulan ve markayı ortaya çıkaran etiket 
türüdür (Görsel 3.5).

Görsel 3.3: Yıkama etiketi

Görsel 3.4: Fiyat etiketi Görsel 3.5: Marka etiketi

Görsel 3.2: Ürün etiketi
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Uyarı Etiketleri: Tüketicilerin ve kullanıcıların tehlikeli madde ve ürünlere karşı korunması 
için hazırlanmış etiket türüdür (Görsel 3.6).

Barkod Etiketler: Ürünlerin üzerine yapıştırılan ve barkod sistemi olan etiket türüdür 
(Görsel 3.7).

Görsel 3.7: Barkod etiket

Ürün ve marka etiket tasarımı yapılırken dikkat edilmesi gereken bazı hususlar vardır.

•	 Markanın logosu dikkat çekecek bir şekilde kullanılmalıdır.
•	 Yapılacak etiket, ürünün temel bilgilerini ve özelliklerini yansıtmalıdır; yazılar açık 

ve okunabilir olmalıdır.
•	 Kullanılan görseller ilk izlenimde dikkat çekmeli ve bilgilendirici olmalıdır.
•	 Tasarım üzerinde kullanılan renkler dikkat çekmelidir.
•	 Seçilen yazı tipi tasarımla uyumlu olmalıdır. 
•	 Ürün hakkında verilen önemli bilgiler en üste büyük puntolarla yazılmalı, diğer bil-

giler ise uygun puntolarla sıralanmalıdır.
•	 Yeterli oranda beyaz alan bırakılmalıdır.
•	 Firmaya ait iletişim bilgileri açık ve net olmalıdır. 

Görsel 3.6: Uyarı etiketi
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Görsel 3.8’i inceleyiniz. Siz de seçtiğiniz bir ürün için etiket eskizini 
Şekil 3.1’in içine çiziniz.

1. Etkinlik

Şekil 3.1

Görsel 3.8: Etiket eskiz örnekleri
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Kağıt Bazlı Etiketler
Kâğıt bazlı etiketlerin üretiminde kâğıt ve türevi malzemeler kullanılır. Kâğıt bazlı etiketler, kuşe ve 
termal olarak üretilir (Görsel 3.10).

Görsel 3.10: Kâğıt bazlı etiket örnekleri

3.1.1. Etiket Çeşitleri
Etiket çeşitleri kendi arasında kâğıt bazlı etiketler ve plastik bazlı etiketler olmak üzere ikiye 
ayrılır (Görsel 3.9). 

Görsel 3.9: Kâğıt bazlı ve plastik bazlı etiketler
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Görsel 3.11: Etiket çeşitleri

Kuşe etiket: Üst kısmı parlak ve pürüzsüz olan kuşe etiket, kâğıt bazlı olduğu için yeteri kadar 
dayanıklı değildir. Isı, sürtünme ve neme karşı dayanıklılığı orta seviyededir.

Fastyre (festyir) etiket: Fiziksel yapısı nedeniyle bir tarafı metalik yapışkandır. Kâğıt bazlı etiket 
sınıfında yer alan fastyre etiket, genellikle tekstil sektöründe kullanılır. 

Eco (eko) termal etiket: Uzun ömürlü bir etiket türü değildir. Bu etiket türünün raf ömrü genellikle 
3-6 ay arasıdır. Bu etiketlerin yüzeyinde koruyucu bir tabaka bulunmaz. Eco termal etiketler, nemli 
ve sıcak ortamlarda kullanılmaz. 

Lamine termal etiket: Lamine etiketin üzerinde koruyucu tabaka bulunur. Kullanım ömrü 6-9 ay 
olan bu etiketler, eco termal etikete oranla daha dayanıklıdır.

Vellum (velım) etiket: Kuşe etiket ile birbirine benzetilir. İki etiket türünün arasındaki fark, vellum 
etikette gözle görülemeyen gözeneklerin bulunmasıdır. 
Termal etiket: Bu etiketler için doğrudan termal baskı yöntemi kullanılabilir ve etiket baskısı alı-
nabilir. Termal etiket aynı zamanda maliyeti düşük etiket çeşitlerindendir.
Floresan etiket: Bu etiket türü suya ve neme karşı dayanıklı değildir. Bu nedenle kolaylıkla yırtı-
labilir. Floresan etiketler sarı, kırmızı, turuncu, mavi ve yeşil renkte üretilebilir.
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Görsel 3.13: Sleeve etiket örneği

Plastik Bazlı Etiketler
Plastik bazlı etiketlerin dayanıklılığı kâğıt bazlı etiketlere oranla daha fazladır. Dayanıklı olmaların-
dan dolayı genellikle sanayi, kozmetik ve kimya sektöründe kullanılırlar. 

Görsel 3.12: Plastik bazlı etiket örnekleri

Lazer yazıcı etiket: Bu etiket türü diğer türlere oranla oldukça dayanıklıdır. Lazer yazıcı ile bası-
lan etiketlerin daha uzun ömürlü ve daha dayanıklı olduğu bilinir. Lazer yazıcı etiket için kullanılan 
kâğıtlar silinmezlik garantisi vermektedir. Barkod yazıcı etiket çeşitlerinden biri olarak kullanılır.
Sleeve (sıliv) etiket: Bu etiket türü, ambalajı tamamen sardığı için diğer bir isimle “çepeçevre 
saran etiket’’ olarak da bilinir. Ambalajın etrafını 3600 çepeçevre saran etiketlerdir. Ambalajların 
dekorlanmasından ürün güvenliğine kadar birçok önemli etkinliğe sahiptir (Görsel 3.13). 
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Görsel 3.15: Şeffaf etiket örnekleri

Kırılgan etiket (güvenlik etiketi): Güvenlik etiketi olarak kullanılan kırılgan etiketler, herhangi bir 
kuvvet uygulandığında kırılarak dağılır. Bu etiket aynı zamanda garanti etiketi olarak da kabul edi-
lebilir. Teknolojik ürünlerin üzerinde kullanılan kırılgan güvenlik etiketi sayesinde ürünlerin tamir 
garantileri takip edilir. Genellikle bilgisayar kasaları ve malzemelerine teknik destek veren firmalar 
tarafından kullanılır (Görsel 3.14).

Görsel 3.14: Kırılgan etiket (güvenlik etiketi)

Şeffaf etiket: Bu etiketlerde etiketin yüzeyi ve zemini görünür. Isı, ışık ve neme karşı dayanıklı 
olan şeffaf etiketler farklı alanlarda kullanılabilir. Şeffaf olduğu için baskı makinesinde görünme-
yen bu etiketler için öncelikle kılavuz baskısı yapılmalıdır (Görsel 3.15).
Silvermat (silvırmet) etiket: Bu etiketlerin iki yüzeyi mat ya da parlak gri renktedir. Hem ısıya 
hem de soğuğa karşı dayanıklıdır. Yapışkanlı özel bir yapıya sahip olan bu etiketler uzun ömür-
lüdür.
Filmictyre (filmiktayır) etiket: Sert malzemelerden yapılmıştır. Zorlanma olmadığı sürece yırtıl-
mayan ve yapısını koruyan etiket türüdür.
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ÖĞRENME BİRİMİ: ETİKET TASARIMI
UYGULAMA ADI   : Ürün Etiketi Eskizi Oluşturma
AMAÇ                    : Etiket eskiz çalışmaları yapmak.

Araç Gereç
1.	 Resim kağıdı
2.	 Kurşun kalem, silgi, çizim araç gereçleri (cetvel, şekil şablonu vb.) 
3.	 Boya malzemeleri
4.	 Bant, makas vb.

Aşağıdaki işlem basamaklarını dikkate alarak etiket tasarımı eskizi çiziniz.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 

güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Konunun içeriğine uygun bir sektör belirleyiniz.
3.	 Belirlediğiniz sektöre ait etiket örneklerini inceleyiniz.
4.	 Eskiz yapılacak kâğıdı çizim masasına sabitleyiniz. 
5.	 Kompozisyon kurallarına uyarak kara kalem ve boyama teknikleriyle eski-

zinizi oluşturunuz.
6.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş şekli sağlığı-

nız için zararlıdır. 
7.	 Çalışmanızı tamamladıktan  sonra çalışmanızı öğretmeninize teslim ediniz.
8.	 İşiniz bittikten sonra çalışma alanınızı temizleyiniz.

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalış-
manız, Ek 1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki 
ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate 
alınız.

1. U
yg

ula
ma



89

Ta
nı

tım
 G

ra
fi

ği

ETİKET TASARIMI

3.2. BİLGİSAYARDA ETİKET OLUŞTURMA
Tasarımcı, etiket tasarımı eskiz çalışmalarını bilgisayara aktardıktan sonra vektörel tabanlı çizim 
programında çalışmasına başlar. Çalışma üzerinde fotoğraf kullanma veya zeminde dolgu ve 
doku kullanma işlemleri için piksel tabanlı program kullanılmalıdır. 

Görsel 3.16: Etiket tasarımı eskizi üzerinden çizim

3.2.1. Bilgisayarda Etiket Tasarımı Aşamaları
Tasarımcı, amatörce hazırladığı eskiz çalışmasını dijital hâle getirerek uygun program yardımı ile 
profesyonel kalitede bir etikete dönüştürür. Böylece ürünü ilgi odağı hâline getirir. Tasarım yapılır-
ken takip edilecek aşamalar ve dikkate alınacak bazı hususlar vardır.

•	 Seçilen ürüne uygun bir renk belirlenerek etiketin zemini oluşturulur. Zeminde kullanılan 
renk ve görsel ögeler, ürünün özelliğini yansıtmalı ve ürün hakkında tüketiciye bilgi ver-
melidir. 

•	 Tüketici, ürünün ambalajını açmadan ürün üzerindeki etiket tasarımından ürünün içeriği 
hakkında bilgi edinebilmelidir. 

•	 Tasarlanan etiketin içeriğine uygun görsel ögeler, vektörel çizim programı yardımı ile 
çizilir ve renklendirilir. Görsel kullanılmadığında renkler ve şekiller ürünün ne olduğuyla ilgili 
fikir vermelidir. 

•	 Tasarımcı, çalışmalasında kullandığı her görsel ögeden sorumludur. Kullanılan yazı ka-
rakterlerinin boyutu, kalınlığı veya inceliği amaca hizmet etmelidir. 
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•	 Firmaya ait logo, geri dönüşüm işaretleri ve diğer bilgilendirme işaretleri tasarıma başlanma-

dan önce vektörel tabanlı çizim programında hazırlanmalıdır. Tasarım için simge ve logoların 

vektörel tabanlı çizim programında çizilmesi istenmeyen görüntülerin oluşmasını engeller. 

•	 Yazı karakterinin algılanabilir ve estetik görünebilmesi tasarım bütünlüğü için önemlidir. Kul-

lanılan yazı alanlarının büyüklüğü ve yazının puntosu rahatça okunabilecek şekilde olmalıdır. 

Okunabilecek en küçük yazı boyutu 5-6 puntodur. Bu durum kullanılan yazı karakterinin özel-

liğine (font) göre farklılık gösterir. Kullanılan yazı karakterinin serifli olması, enine geniş veya 

kalın bir yapıda olması daha küçük puntoların da okunabilmesine olanak sağlar.

•	 Tasarımcı kullanacağı ambalaj simgelerini, simgelerin boyutuna ve yerine dikkat ederek yer-

leştirmelidir. Simgelerin büyük oluşu ürünün önüne geçerek istenmeyen sonuçlar doğurabilir. 

İstenenden küçük kullanıldıklarında ise yapılması gereken uyarılar ve bilgilendirmeler eksik 

kalır. Simgeler ayırt edilebilecek büyüklükte olmalıdır. 

Görsel 3.17: Etiket tasarımı eskizi üzerinden çizim

•	 Her görsel öge, ürün hakkında tüketiciye bilgi vermelidir. 

•	 Baskı anında yaşanabilecek sorunlar dikkate alınarak çalışmaya devam edilmelidir. Belirle-

nen ölçünün taşma payı da hesaba katılarak yeni bir sayfa açılmalıdır. Açılan sayfa üzerine 

ürünün logosu, görsel ögeler ve metin alanlarının yerleşimi yapılarak çalışmaya devam edil-

melidir. Böylelikle markayı ve ürününü mükemmel bir şekilde yansıtan bir tasarım yapılabilir 

(Görsel 3.17). 
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Görsel 3.18: Etiket üzerine simge ve bilgilerin eklenmesi

•	 Etiket üzerindeki bilgilerin tüketici sağlığı açısından doğru olması ve yasalara uygun bir şekil-
de düzenlenmesi gerekir. Etiket üzerinde bulunması gereken bilgiler; ürünlerin fiziksel, kim-
yasal özelliklerini ve besin değerlerini öğrenmek açısından oldukça önemlidir (Görsel 3.18). 

Görsel 3.19: Etiket tasarımının son hâli

Tasarımcı, çalışmasını vektörel çizim programında tamamladıktan sonra CMYK renk formatına 
çevirmelidir. Kullanılan programın kendi kayıt formatında kaydetmelidir. Çalışma üzerinde bulu-
nan bütün ekleri bir dosyanın içine kaydetmelidir.

Etiket tasarımı üzerinde bulunması gereken bilgiler şunlardır:
•	 Ürünün logosu
•	  Ürünün içindekiler kısmı
•	  Ürünün net miktarını belirten 

kısım
•	  Üretimi yapan firmanın adı 

ve net adresi
•	  Üretim yeri
•	  Seri numarası ya da parti 

numarası
•	 Üretimin izin tarihi
•	  Ürünün ait olduğu ülke
•	 Son kullanma tarihi
•	  Ürüne özel uyarı varsa onun 

bilgisi
•	  Muhafaza ve kullanım bilgileri
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Etiket Tasarım Örnekleri

Görsel 3.20: Etiket tasarımları
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Görsel 3.21: Etiket tasarımları
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Görsel 3.22: Etiket tasarımları
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Görsel 3.23: Etiket tasarımları
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ÖĞRENME BİRİMİ: ETİKET TASARIMI
UYGULAMA ADI   : Bilgisayarda Etiket Oluşturma
AMAÇ                    : Vektörel tabanlı çizim programında etiket tasarımı oluşmak.

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları 

Aşağıdaki işlem basamaklarını dikkate alarak vektörel tabanlı çizim 
programında etiket tasarımı çiziniz. 

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı 

ve güvenliği tedbirlerini  alarak özenle hazırlayınız.
2.	 Belirlediğiniz bir sektöre ait etiket örneklerini inceleyiniz.
3.	 Üzerine eskiz yaptığınız kâğıdınızı tarayıcı yardımıyla veya tarayıcı özel-

liği bulunan bir cihazla tarayıp bilgisayar ortamına taşıyınız. 
4.	 Vektörel tabanlı çizim programında konunun içeriğine uygun isim vererek 

yatay bir A4 sayfa açınız.
5.	 Eskizi vektörel tabanlı çizim programının sayfasına taşıyınız.
6.	 Çizerek ve renklendirerek çalışmanıza son şeklini veriniz.
7.	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.	
8.	 Bitirdiğiniz çalışmanızı orijinal formatında ve baskıya uygun formatta kayde-

diniz. 
9.	 Çalışmanızın çıktısını alarak öğretmeninize teslim ediniz.

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalış-
manız, Ek 1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki 
ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate 
alınız.

2.
 U

yg
ula

ma
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ÖLÇME VE DEĞERLENDİRME 
A)   Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise   	
       “Y” yazınız. 

1.	 (   ) Etiketlerin, marka değerini artırma etkisi vardır.
2.	 (   ) Ürün hakkında verilecek önemli bilgiler, etiketin en üstüne küçük puntolarla yazılmalıdır.
3.	 (   ) Etiket çeşitleri kâğıt bazlı etiketler ve plastik bazlı etiketler olmak üzere ikiye ayrılır.

B)   Aşağıda verilen cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.

4.    Kâğıt bazlı etiketlerin üretiminde …………….……... malzemeler kullanılır.
5.    Isı, ışık ve neme karşı dayanıklı olan ……….…..……. farklı alanlarda kullanılabilir.

C)   Aşağıda verilen soruların doğru cevaplarını işaretleyiniz. 

6.	 Aşağıdakilerden hangisi kullanım alanlarına göre günümüzde en çok tercih edilen  
etiket türlerinden biri değildir?
A)	 Fiyat etiketleri
B)	 Marka etiketleri 
C)	 Punto etiketler 
D)	 Uyarı etiketleri
E)	 Ürün etiketleri

7.	 Aşağıdakilerden hangisi kâğıt bazlı etiket türlerinden değildir? 
A)	 Kuşe
B)	 Fastyre
C)	 Termal
D)	 Kırılgan
E)	 Floresan

D)   Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.  

8.	 Plastik bazlı etiketlerin özelliklerini açıklayınız.
	 ……………………………………………………………………………………………………

…………………………………….……………………………………………………………
………………………………………………………………………………………………..…

9.	 Etiket tasarımı yapan bir tasarımcının dikkat etmesi gereken hususlardan üç tanesini 
yazınız.

		 …………………………………………………………………………………………………………
……………………………….…………………………………………………………………………
………………………………………………………………………………….……………………….
.





KONULAR
4.1.	 AMBALAJ MAKETİ ÖN HAZIRLIKLARI
4.2.	 AMBALAJ MAKETİ ESKİZİ

NELER ÖĞRENECEKSİNİZ?
•	 Ambalajın tanımı, özellikleri, çeşitleri ve ambalaj 

tasarımında dikkat edilmesi gereken hususlar 
•	 Kutu ambalajının yapısal ögeleri; kesim, kırım 

çizgilerinin kullanılacağı yerler ve konuya yö-
nelik araştırmaları dosyalama 

•	 Örnek ambalaj çalışmalarını inceleme; ürün için 
uygun ambalaj tasarımı, ambalajın açılımı ve ke-
sim, kırım yerleri; ürün için pencere veya sepa-
ratör ölçüleri 

•	 Üç boyutlu ambalaj maketi hazırlama

TEMEL KAVRAMLAR
•	 ambalaj		 •   kırım
•	 kesim		  •   pencere
•	 separatör

    



100

Ta
nı

tım
 G

ra
fi

ği
AMBALAJ MAKETİ HAZIRLAMA

4.1. AMBALAJ MAKETİ ÖN HAZIRLIKLARI 
Ambalajı hazırlamadan önce ambalajın kullanılacağı 
ürün, hedef kitle, kullanılacak malzeme, nakliye vb. bir-
çok ön bilgiye sahip olmak gerekir. Tasarımcı, bu bilgi-
ler ışığında hazırlayacağı ambalajın maketini hazırlar;  
kullanılacak malzemeye uygun tasarım yapar. 

4.1.1. Ambalaj
TDK Güncel Türkçe Sözlük’te “Eşyayı sarmaya yara-
yan mukavva, kâğıt, tahta, plastik vb. malzeme.” ola-
rak tanımlanmıştır. Ambalaj içinde taşıdığı ürünü dış 
etkenlerden korur ve ürüne ait bütün bilgileri en etkili 
ve net biçimde dışarıya iletir. Ambalaj, bugünkü hâli-
ne gelene kadar çeşitli aşamalardan geçmiştir. Eski 
dönemlerde çuval, deri, toprak kap, ahşap sandık gibi 
malzemeler ambalaj olarak kullanılırken günümüzde 
çoğunlukla kâğıt, karton, ahşap, plastik, cam, metal 
vb. malzemeler kullanılmaktadır. Bu yönüyle daha 
ekonomik ve fabrika üretimleri ile daha ulaşılabilir hâle 
gelmiştir. 

Önceleri yalnızca taşıma ve saklama işlevi olan am-
balaj, günümüzde içindeki ürünün reklamını yapma, 
diğer ürün ambalajlarıyla rekabet edebilme özelliğine 
sahiptir. Bunun yanı sıra içinde bulunan malzemenin 
sağlıklı bir şekilde tüketiciye ulaşması, ürünün hangi 
koşullarda, nasıl saklanması gerektiği ile ilgili bilgilen-
dirme ve iletişim bilgilerini verme gibi işlevleri de vardır. 
Ambalaj ürünün giysisidir. Alıcı üzerinde iyi bir izlenim 
bırakması için sağlam ve şık bir tasarım gerektirir.

Sanayi Devrimi sonrası kitlesel tüketimin hızla artması; 
ürünleri korunma, depolanma ve taşınma problemleri-
ni beraberinde getirmiştir. Bunun sonucunda ambalajın 
ihtiyacı artmış ve ambalaj tasarımı da bu süreçte önem 
kazanmıştır. Üzerinde bulunan tipografik unsurlar, 
renkler, illüstrasyon ve fotoğraflar ile aslında bir iletişim 
aracı olan ambalajın tüketiciyle görsel iletişimi doğru 
kurabilmesi ve bunu yaparken de etkileyici olabilmesi 
gerekir. 

Hazırlık Çalışmaları

Bilgi Kutusu
Ambalaj Atığı Çöp Değildir!
Günümüzde; hemen hemen 
her sektörde birçok ürünün 
ambalajlı olarak satışa sunul-
duğunu görüyoruz. Ambalaj 
malzemelerinin üretimi ve tü-
ketimi de endüstriyel gelişmeye 
paralel olarak her geçen gün 
artıyor. Gündelik hayatımızda 
pek çok ürünü cam, metal, 
plastik, kâğıt gibi ambalajlar 
içinde satın alıyoruz. Ambalaj 
kullanımı artarken ambalaj atığı 
miktarı da artmaktadır. İçinde-
ki ürünü tükettikten sonra bu 
ambalaj atıkları işe yaramaz 
deyip çöpe atıyoruz. Ne yazık 
ki çöp alanlarında çöp dağları 
oluşturuyoruz. Ürettiğimiz atığın 
yaklaşık %20’sini ambalaj atığı 
oluşturmaktadır.
Doğal kaynaklarımız dünya 
nüfusunun artması ve tüketim 
alışkanlıklarının değişmesiyle 
birlikte her geçen gün azalıyor. 
Öncelikle az atık oluşturmalıyız, 
atık oluşumunun    kaçınılmaz 
olması durumunda da atıkları-
mızı tekrar kullanmalı veya geri 
dönüşüme gitmesine yardımcı 
olmalıyız.
Kaynak: 

https://webdosya.csb.gov.tr/db/
bolu/icerikler/atiklarin-geri-kazani-
mi-20180222082519.pdf   (18.08.2021)

1.	 Markette ilginizi en çok çeken ambalajlar hangileridir? Ürünün paketini tarif 
ediniz.

2.	 İlk defa aldığınız ve birçok markanın ürettiği bir ürünü seçerken nelere dikkat 
edersiniz?

3.	 Sizce okul kantininden aldığınız ürünlerin ambalajları nasıl olmalı?
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Ambalaj tek başına bir iletişim aracı olmakla beraber formu, üretim malzemesi ve grafik tasarı-
mıyla bir bütün olarak düşünülmelidir. Formunun kullanışlı olmasının ve ürünü muhafaza etmesi-
nin insan hayatını kolaylaştırdığı söylenebilir. Ancak üzerinde grafik tasarım olmadan ambalajın 
içinde ne olduğunun anlaşılabilmesi oldukça güçtür. Grafik tasarım; ürünün içecek mi, temizlik 
malzemesi mi, deterjan mı yoksa hazır çorba mı olduğunun anlaşılmasını sağlar. Aynı zamanda 
tüketiciye ürünün son kullanma tarihi, içeriği gibi gerekli bilgileri sunar.  Bu durumda, tasarımcı, 
ambalaj üzerindeki tasarım sayesinde hedef kitleyle doğru şekilde görsel iletişim kurabilmelidir.

Okul kantinindeki ambalajlı ürünleri inceleyiniz. Aşağıdaki soruların ce-
vaplarını noktalı yerlere yazınız.

1. En çok tercih ettiğiniz ürünün ambalajının özelliklerini yazınız.

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … …

… … … … … … … … … … . … … … … … … … … … … … . . … … … … … … … … …

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … …

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … … .

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … … .

2. Kantinde en çok talep edilen ürünün ambalajının özelliklerini yazınız.

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … …

… … … … … … … … … … . … … … … … … … … … … … . . … … … … … … … … …

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … …

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … … .

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … … .

3. Siz bir ambalaj tasarlıyor olsaydınız bu ambalajın ne tür özellikleri olsun is-	
    terdiniz? Yazınız. 

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … …

… … … … … … … … … … … … … … … … … … … … … … … … … … … … . … …

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … …

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … … .

… … … … … … … … … … … … … … … … … … … … … … … … … … … … … … … .

1. Etkinlik
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4.1.2. Ambalaj Özellikleri
Ambalajların ürün özelliklerine uygun olması dışında farklı özellikleri de bulunur. Ambalajın tasa-
rımı ve üretimi aşamasında aşağıdaki özellikler göz önünde bulundurulmalıdır.

•	 Ürün için farklı üreticilere farklı tasarımlar sunmalıdır. 
• 	  Nakliye ücreti ve ürün fiyatını çok fazla etkileyecek maliyette olmamalıdır.
• 	  Sağlığa zararlı maddelerden üretilmemelidir.
• 	  Geri dönüştürülebilir olmalıdır.
• 	  Ürünün yapısını bozmadan taşınmasını sağlamalıdır.
• 	  Hedef kitleye mesajı doğru vermeli ve ürün özelliklerini aktarmalıdır.
• 	  Depolama, nakliye ve satış sırasında kirliliğe sebep olmamalıdır.,

Görsel 4.1: Metal ambalaj

Ambalajın taşıma ile ilgili işlevleri:
•	 Ürünleri bir arada tutması,
•	 Nakliye aracına kolaylıkla yüklenip bo-

şaltabilmesi,
•	 Akma, dökülme, patlama, ve dağılma-

yı önlemesidir.

Ambalajın depolama ile ilgili işlevleri:
•	 Üst üste yığılabilmesi, 
•	 Depo içinde yerinin kolayca değiştiri-	
	 lebilmesi, 
•	 Ayırt edilebilmesinin kolay olmasıdır.                                   

Görsel 4.2: Taşıma        

Görsel 4.3: Depolama 

Ambalajdan Beklenen İşlevler
Ambalajın koruma, taşıma, depolama, pazarla-
ma, çevre kirliliği ve tüketici açısından çeşitli iş-
levleri vardır.

Ambalajın, içindeki ürünü koruma ile il-
gili işlevleri:	

•	 Mikrobiyolojik yönden koruması, 
•	 Nem ve atmosferik etkiler yönünden 

koruması,        
•	 Çarpma, ezilme gibi mekanik etkiler-

den korumasıdır (Görsel 4.1). 
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Ambalajın pazarlama ile ilgili işlevleri:	
•	 Satış sırasında göze çarpması,
•	 Rafta az yer işgal etmesi,
•	 İçindeki ürünle ilgili bilgi verici yazılar 

bulundurması,
•	 Yasal kurallarla kısıtlamalara uygun ol-

masıdır. 
                                

Ambalajın tüketici açısından işlevleri:	
•	 Çekici bir görünümde olması,
•	 Kullanışlı ve açılır kapanır özellikte ol-
	 ması,
•	 Ürün tüketildikten sonra ambalajın ye-	

niden kullanılabilmesi,
•	 Taşıdığı ürün ile ilgili gerekli bilgileri 

bulundurmasıdır. 

Ambalajın çevre kirliliği açısından işlevleri:               
•	 Kullanıldıktan sonra atıldığında kimya-

sal ve biyolojik yönlerden çevre kirlili-
ğine neden olmaması,

•	 Büyük çöp yığınları meydana getirip 
yok edilmesi için ilave bir masraf ge-
rektirmemesi,

•	 Geri dönüşümle tekrar kullanılır hâle 
getirilebilmesidir.

                                

Görsel 4.4: Pazarlama

Görsel 4.5: Tüketici

Görsel 4.6: Geri dönüşüm
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4.1.3. Ambalaj Çeşitleri
Ambalajlar kullanım durumuna göre ve kullanılan malzemeye göre farklılık gösterir. Kullanım du-
rumuna göre olan ambalajlar satış ambalajı, grup ambalajı, nakliye ambalajıdır. Bunlar üretim, 
nakliye ve hedef kitleye doğrudan ulaştırılırken ürünün zarar görmesini engellemek için kullanılan
ambalajlardır.

Kullanılan Malzemeye Göre Ambalajlar
Ambalajlar içindeki malzemenin özelliğine göre ahşap, metal, alüminyum, plastik, kâğıt gibi 
farklı malzemelerden üretililir.

Ahşap Ambalaj  
Dayanıklı yapısı ile ürünün korunaklı bir şekilde ulaşımını sağlar. Ahşap, organik bir malzeme 
olduğu için ambalaj sektöründe kullanılır. Havalandırma özelliğinden dolayı taze meyve, sebze 
satışında tercih edilir. İhracatta kullanılan ahşap ambalaj malzemeleri; palet, kasa, kutu, sandık 
ve varillerdir (Görsel 4.8). 

Görsel 4.7: Çeşitli ambalajlar

Görsel 4.8: Ahşap ambalajlar



105

Ta
nı

tım
 G

ra
fi

ği

AMBALAJ MAKETİ HAZIRLAMA

Metal Ambalaj 
Çeşitli minerallerin işlenerek saflaştırılması sonucunda üretilen metal ambalajlar, taşıdıkları ürü-
nü nem ve ışıktan korur. İlaç, kimya, kozmetik ve gıda sanayisinde genellikle konserve kutuları, 
meşrubat kutuları, boya kapları vb. olarak kullanılan ambalaj çeşididir (Görsel 4.9). Kötü şartlarda 
bile ürünün bozulmadan saklanmasını sağlar.

Görsel 4.9: Metal ambalajlar

Alüminyum Ambalaj
Buhar ve gaz geçirgenliğinin olması, içindeki gı-
dada nem ve su kaybının oluşmaması, gıdanın 
bozulmasını önlemesi, kolay boyanabilir olması, 
metal kaplara oranla daha hafif ve şekillenebilir 
olması alüminyum ambalajların avantajlarından-
dır. Dış etmenlere karşı tenekeye göre dayanık-
sız ve sağlık açısından zararlı oluşu dezavan-
tajlarındandır. Alüminyum folyoyla şekil verilmiş 
paket kaplar veya torbalarda, poşet tarzında pa-
ketlerde kullanılırlar (Görsel 4.10).

Plastik Ambalaj                                                                   
Plastikler; ısı ya da basınç etkisiyle yumuşatılıp kalıba dökme ve haddeleme gibi çeşitli yöntem-
lerle biçimlendirilebilen, bu biçimlerini soğuyunca da koruyabilen, yapay ya da doğal, çoğunlukla 
organik malzemelerdir. Plastik ambalajlar; hafif, saydam, nem geçirgenliği düşük, haşerelere kar-
şı dayanıklı olması, kimyasal veya atmosferik durumlardan etkilenmemesinden dolayı kullanım 
alanı geniş olan ambalajlardır. Poşet, torba, çanta, kavanoz, şişe, kova, tüp, bidon gibi sonsuz 
şekillerde biçimlendirilerek kullanılır (Görsel 4.11).

Görsel 4.10: Alüminyum ambalaj

Görsel 4.11: Plastik ambalajlar
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Cam Ambalaj
Cam, silis kumunun çeşitli katkı maddeleri ile yüksek sıcaklıklarda eritilerek şekillendirilmesiyle 
meydana gelir. Özellikle sıvı ve yarı sıvı ürünlerin ambalajında kullanılır. Gıda, kozmetik, kimya 
sanayisinde kullanılmaktadır. Gaz, su buharı, koku ve sıvı geçirgenliği yoktur. Cam ambalajlar 
sağlık açısından güven verir ve içindeki ürünün görünürlüğünü sağlar. Ağırlığı nedeniyle nakliye 
masraflarının fazla oluşu ve kırılma gibi dezavantajları vardır. Geri dönüşüm açısından avantaj-
lıdır. 

Görsel 4.12: Kâğıt ambalajlar

Görsel 4.13: Cam ambalajlar

Kâğıt Ambalaj
Üretim maliyetinin az olması, az yer kaplaması, depolama ve taşıma maliyetinin az olması ve 
geri dönüşüm yapılabiliyor olmasından dolayı en çok tercih edilen ambalaj türüdür. Kâğıdın ham 
maddesi selülozdur. TDK Güncel Türkçe Sözlük’e göre selüloz; bitkilerde hücre yapısının büyük 
bir bölümünü oluşturan kâğıt, yapay ipek ve patlayıcı maddelerin yapımında kullanılan karbon-
hidrattır. 
Kâğıt ambalajlar beş farklı şekilde kullanılır.

•	 Sargılık kâğıtlar: Ürünlerin etrafını sarmak için kullanılan kâğıt türleridir. Margarinlerin 
ambalajları sargılı kâğıt örneğidir. 

•	 Karton kutular: Kuru gıda ve toz deterjan kutuları örnek verilebilir.
•	 Oluklu mukavva kutular: Bir veya daha fazla oluklu mukavva tabakanın alt ve üst yü-

zeylerinin düz tabaka mukavvayla kaplanması ile meydana gelen üründür. Ürünlerin nak-
liye aşamasında kullanılır.

•	 Viyol: Yumurtaların taşınırken birbirine çarpmasını önleyen, çukurları olan bir ambalaj 
türüdür.
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4.1.4. Ambalaj Çeşitlerinde Geri Dönüşüm 
Geri dönüşüm, atıkların özelliklerinden yararlanılarak içindeki bileşenlerin fiziksel, kimyasal 
veya biyokimyasal yöntemlerle başka ürünlere veya enerjiye çevrilmesidir. Ambalaj çeşitlerinin 
geri dönüşümünü içeren bilgiler Çevre ve Şehircilik Bakanlığı, Bolu, Atıkların Geri Kazanımı, 
20180222082519 numaralı dökümandan alınmıştır.
Metal ambalaj: Evlerimizde gıda ve içecek ambalajında kullanılan iki çeşit metal ambalaj mal-
zemesi vardır. Bunlar teneke ve alüminyumdur. Metal ambalajların eritilerek geri dönüştürülmesi 
kullanılmış daha az enerji ve hammadde tüketimi demektir. Kullanılmış alüminyumdan alüminyum 
üretilerek sera gazı emisyonu % 95 ve atık su kirlenmesi % 97 oranında azaltılabilir.
Plastik ambalaj: Plastik ambalaj atıkları yıkanıp eritilerek, granül haline dönüştürülmektedir. Gra-
nüller ikincil ürün imalatında hammadde olarak; plastik torba, marley, pis su borusu, elyaf, dolgu 
malzemesi, çerçeve ve sera örtüsü imalatı ile otomotiv sektöründe kullanılarak yeni ürünler elde 
edilmektedir. 2.5 lt.’lik bir plastik şişe geri kazanılıp üretimde kullanılırsa 6 saatlik 60 watt’lık elekt-
rik enerjisini tasarruf etmek mümkündür. 25 adet geri kazanılmış içecek şişesinden bir plastik 
mont elde etmek mümkündür.
Kâğıt ambalaj: Kullanılmış kartonlardan; masa, sandalye ve dolap gibi mobilyalar üretilmekte, 
ayrıca kâğıt hammaddesi olarak da kullanılmaktadır. Bir ton atık kâğıdın geri dönüştürülmesi ile 
17 ağaç kurtarılmış olur.
Cam ambalaj: Cam şişeler depozitolu ve depozitosuz olarak ikiye ayrılır. Depozitolu şişeler te-
mizlenerek tekrar kullanılır. Depozitosuz olanlar ise, diğer cam atıklar ile birlikte renklerine göre 
ayrılmak suretiyle, kırılarak cam tozu haline getirilerek yeni ürünlere dönüştürülür. Bir cam şişe 
geri dönüştürüldüğünde, 100 Wattlık bir ampulü dört saat yakabilecek enerji tasarruf edilmiş olur.

Aşağıda verilen ambalaj çeşitlerinin kullanıldığı ürünleri yazınız.

2. Etkinlik

Kâğıt ambalaj

1. . . . . . . . . . . . . . . . . . . 

2. . . . . . . . . . . . . . . . . . . 

3. . . . . . . . . . . . . . . . . . . 

Plastik ambalaj

1. . . . . . . . . . . . . . . . . . . 

2. . . . . . . . . . . . . . . . . . . 

3. . . . . . . . . . . . . . . . . . . 

Cam ambalaj

1. . . . . . . . . . . . . . . . . . . 

2. . . . . . . . . . . . . . . . . . . 

3. . . . . . . . . . . . . . . . . . . 
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4.1.5. Ambalaj Tasarımında Dikkat Edilmesi Gereken Hususlar
Ambalaj tasarımı yapım aşamasında ürünün tüm özellikleri göz önünde bulundurularak tüketici 
üzerinde olumlu etki bırakacak şekilde tasarım yapılmalıdır.

•	 Tasarım sade ve estetik olmalıdır.
•	 Ürün hakkında bilgi vermelidir.
•	 İlgi çekici olmalı, rakipleri arasından sıyrılabilmelidir.
•	 Kullanılan renkler ürünün özelliğine ve tüketici üzerinde bırakacağı psikolojik etkiye göre 

tercih edilmelidir.
•	 Ambalaj üzerinde bulunması gereken marka, içindekiler, tüketim tarihi gibi zorunlu ögeler 

kolay okunabilir olmalıdır.
•	 Ambalaj tasarımı yapılırken kesim, kırım yerleri doğru hesaplanmalıdır.

4.1.6. Kutu Ambalajın Yapısal Özellikleri
Kutu ambalajı tasarlanırken yapısal özellikler bilinmelidir. Kırım ve kesim yerleri, yapıştırma payı, 
kilit sistemleri, barkot, pencere ve tasarım alanları ürünün yapısına uygun olmalıdır. Ambalajın 
yapısal özelliklerinin yerleşimi, ürün özelliklerini tüketiciye iletebilecek şekilde planlanmalıdır.
Kırım (Pilyaj) Yerleri: Katlama işleminin düzgün ve kolay yapılabilmesi için ezme işleminin yapıl-
dığı yerlerdir. Ambalajın tasarımı esnasında noktalı kesik çizgi ile belirtilir.
Kesim Yerleri: Kesilmesi gereken yerleri belirten çizgilerdir. Ambalajın tasarımı esnasında düz 
çizgi ile belirtilir.

Görsel 4.14: Ambalaj tasarımını etkileyen unsurlar

AmbalajAmbalaj
tasarımıtasarımı

Tüketici 
davranışları

Ürünün üretim
süreci

Dağıtım 
kanalları

Rekabet

Yasal 
sınırlılı

klar

Sosyal v
e 

kültürel 
sorunlar

Ekonomik 
faktörler

Teknol
oji
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Perforaj: Kolay koparılması istenen bölümlere yapılan aralıklı kesme işlemidir.
Yapıştırma Payı: Kesme ve kırım işlemi bittikten sonra ambalajın kutu hâline getirilmesi için ya-
pıştırılacak alandır.
Kilit Sistemleri: Ürün ambalaja yerleştirildikten sonra kapağın rahat açılıp kapanması için gerekli 
olan bölümdür. Ambalajın şekline göre farklı biçimlerde oluşturulabilir. 
Barkod Alanı:  Barkod, ürüne sayısal olarak verilen isimdir. Her ürünün kendine özgü bir kod nu-
marası vardır ve bu kod başka bir üründe kullanılamaz. Barkodlar, ürünün barkod okuyucuda oku-
tulup tanımlanması için kullanılır. Genellikle ambalajın sol yan veya sağ yan yüzüne yerleştirilir.
Görsel Tasarım Alanları: Genellikle ürün hakkında bilgi veren, somut veya soyut görseller kulla-
nılarak farklı tasarımlar yapılan alandır. Ürünün tanıtımının yapıldığı bölümdür. Ağırlıklı olarak ön 
ve arka yüzde bulunur.
Separatör (Ayırıcı): Ambalaj ile ürün arasına yerleştirilen karton, oluklu mukavva, strafor ya da 
hava yastığına separatör denir. Çarpmalara, düşmelere karşı ürünün zarar görmesini önlemek 
için kullanılır (Görsel 4.15).

Pencereli Kutu: Ürünün görünebilmesi için kullanılan, ayrıca farklı tasarım imkânları sunan bö-
lümdür. Kutu ambalajlar, tüketicinin paketi açmadan ürünü görmesini sağlar. Pencere için be-
lirlenen alan genellikle ön yüzde bulunur. Kutu içindeki ürünün kutudan çıkmasını önlemek için 
genellikle saydam bir malzeme ile kapatılır (Görsel 4.16).

Görsel 4.15: Separatör

Görsel 4.16: Kutu ambalajda pencere kullanımı

Pencere
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3. Etkinlik
Görsel 4.18’ deki kutu ambalaj ile ilgili aşağıdaki 
soruların cevaplarını noktalı yerlere yazınız.

1.	 Ambalaj ne tür bir ürün için tasarlanmış olabilir?

	 ………………………………………………………

2.	 Ambalaj tasarımı için seçilen malzeme uygun 
mu?

	 ………………………………………………………

	 ………………………………………………………  

3.	 Ambalajın özelliklerini sıralayınız.

	 ………………………………………………………

	 ………………………………………………………
Görsel 4.18: Kutu ambalaj

Üst kapak kilidi

Alt kapak kilidi

Yan kulakYan kulak

Yan kulak Yan kulak

Kesim çizgisi

Kırım çizgisi (pilyaj)

Barkod alanı

Yapıştırm
a payı

Üst kapak

Görsel tasarım alanı 

Alt kapak

Görsel tasarım alanı 

Arka yüz

Görsel tasarım alanı 

Ön yüz

Görsel tasarım alanı 

Pencere 

Yan yüz

Görsel tasarım 
alanı 

Yan yüz

Görsel tasarım 
alanı 

Görsel 4.17: Kutu ambalaj açılımı
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4. Etkinlik
Görsel 4.19’da numaralan-
dırılan bölümlerin isim-
lerini aşağıya yazınız.

1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

3. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

4. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Görsel 4.19: Kutu ambalaj açılımı 

4.1.7. Ambalaj Araştırma, Veri Toplama ve Dosyalama 
Günümüzde insanlar eskiye oranla daha hareketli bir yaşam sürmektedir. Ambalaj tasarımı da 
bu hareketli yaşama ayak uydurmak durumundadır. Robert Opie’nin (Rabırt Opi) 1991 yılında 
yayımlanan “Packaging Source Book” [Pekicin Sours Buk (Paketleme Kaynak Kitabı)] adlı kita-
bında ambalajın temel işlevleri, “ürüne daha iyi bir görünüm kazandırmak ve ürünün dağılımını 
kolaylaştırmak” olarak verilmiştir. Günümüz şartlarında bu işin daha karmaşık bir yapı kazanma-
sıyla birlikte ambalajın işlevleri artmıştır. Bu yeni işlevler arasında göze en çarpanı, gittikçe artan 
pazar karmaşası içindeki konumudur (Görsel 4.20). Ambalaj tasarımının ana hedefi, bir tüketim 
ürününün kimliğini ya da işlevini ayırt edici bir yöntem aracılığıyla ileterek ürüne ilişkin pazarlama 
problemlerine çözüm bulmaktır.
Sektör analizinde detaylı araştırmalar yapılarak elde edilen veriler dosyalanmalıdır. Bir üründen 
her açıdan maksimum fayda sağlamak adına ambalaj, bu veri dosyasındaki bilgiler doğrultusun-
da tasarlanmalıdır. Sektör analizinde araştırılması gerekenler şunlardır:

•	 Ürün ile ilgili mevcut bütün özellikler ve benzerlerinden ayrılan özellikler
•	 Hedef kitle ile ilgili demografik (cinsiyet, yaş, gelir düzeyi, meslek, eğitim vb.) özellikler 

başta olmak üzere üründen beklenenler
•	 Pazar ile ilgili pazar olarak kabul edilecek bölge başta olmak üzere ürün ile aynı ve ben-

zer olan ürünlerin pazar payları ve satış ciroları
•	 Üretici firmanın kısa ve uzun vadede üründen net beklentileri 

Görsel 4.20: Ambalajın market raflarındaki görünümü

1

2

3

5

4
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ÖĞRENME BİRİMİ: AMBALAJ MAKETİ HAZIRLAMA
UYGULAMA ADI   : Kutu Maketi Hazırlama
AMAÇ                    : Kutu maketi için gerekli ön hazırlıkları yapma.

Araç Gereç
1.	 Ambalaj örnekleri
2.	 Bilgisayar 

Belirlediğiniz bir ürün için farklı özelliklerde ambalaj örnekleri araştırıp, 
aşağıdaki işlem basamaklarını dikkate alarak dosya oluşturunuz.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 

güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Belirlediğiniz ürünün tüm özelliklerini yazınız.
3.	 Zamanınızı verimli kullanmaya, sabırlı ve özenli çalışmaya dikkat ediniz.
4.	 Belirlediğiniz ürün ile aynı ve benzer olan ürünlerin pazar payları hakkında 

bilgi toplayınız.
5.	 Üretici firmanın kısa ve uzun vadede üründen beklentilerini belirleyiniz.
6.	 Bilgisayar ortamında dosya oluşturarak topladığınız verileri oluşturduğu-

nuz dosyaya kaydediniz.
7.	 Hazırladığınız dosya sunumunu sınıf ortamında arkadaşlarınızla saygı 

ve sevgi çerçevesinde paylaşınız.

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalış-
manız, Ek 1’de verilen “Ambalaj Maketi Hazırlama Değerlendirme Formu” veya 
“Ambalaj Maketi Hazırlama Kontrol Listesi”ndeki ölçütlere göre değerlendirile-
cektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

1. U
yg

ula
ma
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4.2. AMBALAJ MAKETİ ESKİZİ
Ambalaj maketi eskizi oluşturulurken kutunun açık  ve kapalı hâli birlikte düşünülmelidir. 
Ambalaj için tasarımı yapılacak ürünü taşıyabilecek özellikte bir malzeme seçilmelidir. İstenen 
ambalaj  özelliklerine dikkat edilerek  yani “Pencereli bir ambalaj mı yoksa penceresiz bir ambalaj 
mı olmalı, görsel tasarım alanı için belirlenen bölümün genişliği ve kutunun ebatları nasıl omalı, 
separatöre ihtiyaç var mı?” gibi sorular yanıtlanmalı ve bu doğrultuda tasarım süreci doğru 
planlanmalıdır.

4.2.1. Kutu Açılımı Çizimi
Kutu açılımı çizilirken dikkat edilecek bazı noktalar vardır.

•	 Ölçüler bire bir çizilmelidir. Ölçülerde meydana gelen hata, kutu katlanıp üç boyutlu ma-
ket hâline getirilene kadar anlaşılamaz. Geri dönüşü zor hataların meydana gelmemesi 
için ölçüm düzgün yapılmalıdır.

•	 Malzeme israfı yapmamak için açılım çizilecek malzeme, ölçülerine uygun ve düzgün 
kesilmeli ya da açılımın dıştan dışa en ve boy ölçülerine göre dörtgen bir çerçeve içine 
oturtulmalıdır. 

•	 Çizim yapılırken her adımda bir önceki adımın ölçüsünden yararlanılmalı ve bu sürekli 
kontrol edilmelidir.

•	 Geometrideki “İki noktadan bir doğru geçer.” kuralına uyularak çizilecek her doğru için 
en az iki noktadan ölçüm yapılmalıdır. Yatay ve dikey çizgilerin eğri çizilmemesi için bu 
kurala uyulması zorunludur. 

•	 Ambalaj için kullanılacak malzeme, verilen ölçülere uygun şekilde bire bir kesilmeli ya 
da verilen ölçülere uygun bir dikdörtgen, malzeme üzerine çizilmelidir. Malzeme, çizim 
yapılacak yere sabitlenmelidir.

•	 Yatay çizgilerden başlanarak çizim işlemine geçilmelidir. İlk olarak yan yapıştırma kulağı, 
karton kenarına sıfır ya da çizilen dikdörtgene sıfır çizilmeli; düşey çizgilerle çizime de-
vam edilmelidir. 

•	 Kutu tabanının katlama ve kilit kulakları çizilmeli, kesim ve kırım çizgileri dışındaki fazla 
çizgiler silinmelidir. Kesim çizgileri, düz çizgi ile belirlenmeli; kırım çizgileri, kısa çizgi ile 
belirlenmelidir. Böylece çizim tamamlanmış olur.
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Görsel 4.21: Kutu açılımı çizim aşamaları
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Görsel 4.22’de verilen ölçüleri ve aşağıdaki işlem basamaklarını dikka-
te alarak kutu ambalajın açık hâlini çiziniz.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı 

ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Maketin oluşturulacağı yüzeyi sabitleyerek malzemenin kaymamasına 

dikkat ediniz.
3.	 Maketin açılımını ölçülerine dikkat ederek yüzeye çiziniz.
4.	 Maketin kesim ve kırım yerlerini yüzeye çiziniz. 
5.	 Ambalaj açılımının çizimini bitirdikten sonra çiziminizi inceleyiniz. Ölçü-

lerin, kırım ve kesim çizgilerinin doğruluğunu kontrol ediniz.
6.	 Planlı ve disiplinli çalışmaya özen gösteriniz.
7.	 Çalışmanız bittikten sonra çalışma ortamınızı temizleyiniz.

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Ça-
lışmanız, Ek 1’de verilen “Ambalaj Maketi Hazırlama Değerlendirme Formu” 
veya “Ambalaj Maketi Hazırlama Kontrol Listesi”ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

55 cm

24 cm 24 cm

7 cm
3,5 cm

1,5 cm

2,5 cm

35 cm 26 cm

3 cm

2 cm

3 cm

2 cm

2 cm

2 cm

4 cm

23 cm

7,2 cm

Görsel 4.22: Kutu ambalaj açılımının çizimi

ÖĞRENME BİRİMİ: AMBALAJ MAKETİ HAZIRLAMA
UYGULAMA ADI   : Kutu Ambalaj Eskizi Hazırlama
AMAÇ                    : Kutu maketi için eskiz yapma.

Araç Gereç
1.	 50x70 cm resim kâğıdı
2.	 Çizim kalemi
3.	 Silgi
4.	 Cetvel 2.
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4.2.2. Ambalaj Çalışma Örnekleri

Görsel 4.23
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Görsel 4.24
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Görsel 4.25 
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Görsel 4.26
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Görsel 4.27
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Görsel 4.28
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Ambalaj Eskiz Çalışmaları

Görsel 4.29: Kutu ambalaj çizimi örnekleri
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4.2.3. Ambalaj Maketi Hazırlama 
Eskiz çalışmasında beyin ve el koordinasyonu sağlanır. Bu sayede özgürce, hiçbir kısıtlama olma-
olmadan çok sayıda fikir üretilebilir. Ambalaj maketi hazırlarken dikkat edilmesi gereken aşa-
malar şunlardır:
	 •	 Hazırlanması planlanan ambalaj eskizinin ölçüleri belirlenerek ambalaj için seçilen uygun 
		  malzemeye çizilir. Ölçülere dikkat edilmesi gerekir çünkü 1 mm hata bile ambalajın hazır-	

	 lanmasında sorun oluşturur (Görsel 4.30).
•	 Kesim için düz çizgi, kırım için kesik çizgi kullanılır. Kırım, kesim çizgilerinin doğru belir-

lenmesi çok önemlidir. Ambalajın tasarımı bittikten sonra kutu hâline dönüşebilmesi için 
kırım ve kesim çizgilerinden faydalanılır.

                                                                                     

Görsel 4.30: Çizim aşaması

•	 Ambalaj maketi hazırlarken maket belirlenen kesim çizgilerinden kesilir (Görsel 4.31).

Görsel 4.31: Kesim aşaması

•	 Kırılma yerleri, ambalaj için seçilen malzeme buruşturulmadan dikkatli bir şekilde 
kırım çizgilerinden katlanır (Görsel 4.32).

•	 Yapıştırılması gereken parça, yapıştırıcı yardımı ile yapıştırılır.

Görsel 4.32: Kırım ve yapıştırma aşaması
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•	 Ambalaj maketinin kapak kilit sistemleri de kullanılarak, makete son şekli verilip maket kutu hâline 
getirilir (Görsel 4.33).

Görsel 4.33: Ambalaj maketi

Aşağıdaki işlem basamaklarını dikkate alarak hayalî bir ürün için ambalaj eskizi 
çiziniz.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve gü-

venliği tedbirlerini alarak özenle hazırlayınız.
2.	 Öğretmeniniz ile bir ürün belirleyiniz ve bu ürün için beş farklı ambalaj eskizi çiziniz.
3.	 Arkadaşlarınızla beyin fırtınası yapınız, fikirlerinizi birbirinizle paylaşarak yar-

dımlaşınız.
4.	 Ambalaj eskizlerinizi resim kâğıdına çiziniz.
5.	 Ambalajınızın açık ve kapalı hâlini planlayıp çiziminizi yapınız.
6.	 Kesim ve kırım yerlerini belirleyerek çiziniz. 
7.	 Eskiz çizimlerinizi arkadaşlarınız ve öğretmeninizle paylaşarak fikirlerini alınız.
8.	 Eskiz çizimlerinizi sonra kullanmak üzere dosyanızda özenle saklayınız.
9.	 Planlı ve disiplinli çalışmaya özen gösteriniz.
10.	Çalışmanız bittikten sonra çalışma ortamınızı temizleyiniz.

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, 
Ek 1’de verilen “Ambalaj Maketi Hazırlama Değerlendirme Formu” veya “Ambalaj Ma-
keti Hazırlama Kontrol Listesi”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı 
yaparken bu ölçütleri dikkate alınız.

ÖĞRENME BİRİMİ: AMBALAJ MAKETİ HAZIRLAMA
UYGULAMA ADI   : Kutu Ambalaj Eskizi Hazırlama
AMAÇ                    : Ambalaj tasarımı için eskiz çalışmaları  yapma.

Araç Gereç
1.	 50x70 cm resim kâğıdı
2.	 Çizim kalemi
3.	 Silgi
4.	 Cetvel 3. 
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4.2.4. Pencereli Ambalaj Maketi Hazırlama 
Kutu ambalajında pencereli tasarımlar da mevcuttur. Pencereli ambalajın yapım aşamaları şun-
lardır:

•	 Tasarımı yapılacak ürüne benzer ürünler için tasarlanmış pencereli ambalaj örnekleri 
incelenerek sektör analizi yapılır. 

•	 Ürünün taşınması için uygun malzeme seçilir. 
•	 Eskiz çizimleri yapılarak, ürün için en doğru ambalaj eskizi seçilip çizim yapılır (Görsel 4.34).                                                                                              

Görsel 4.34: Maketin açık ve kapalı hâlinin çizimi
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•	 Maket hazırlama işlemine başlanırken ölçüler, ürüne uygun bir şekilde belirlenir. Ölçüler, be-
lirlenip çizilirken 1 mm’lik hata bile ambalaj maketinin son aşamasında problem oluşturur. Bu 
sebeple ölçülerin titizlikle yapılması önemlidir.                                                                                          

Görsel 4.35: Çizim aşaması  

•	 Maketin oluşturulacağı yüzey sabitlenerek malzemenin kaymamasına dikkat edilir.
•	 Maketin açılımı yüzeye çizilir (Görsel 4.35).		   
•	 Maketin kesim ve kırım yerleri pencerenin kullanılacağı alan belirlenerek yüzeye çizilir. 
•	 Ambalaj açılımının çizimi bitirildikten sonra ölçülerin doğru bir şekilde çizilip çizilmediği kontrol 

edilir.
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Görsel 4.36: Kesim ve kırım aşaması  

Görsel 4.38: Ambalaj maketi   Görsel 4.37: Yapıştırma aşaması   

•	 Yüzey kesim çizgileri takip edilerek kesilir. Düz kenarlar için maket bıçağı, oval kenarlar için 
makas tercih edilmelidir. Pencere bölümünün kesim işlemi maket bıçağı ile yapılır (Görsel 4.36).

•	 Kırım yerleri için keskin olmayan sert bir cisimle iz bırakacak şekilde kırım işlemi yapılır.
•	 Yapıştırma kulakları olarak belirlenen bölümler yapıştırıcı taşırılmadan yapıştırılır (Görsel 4.37).
•	 Maketin kapak kilit sistemleri de kullanılarak maket, yapıştırma kulaklarından birleştirilir ve 

makete son hâli verilir (Görsel 4.38).
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Aşağıdaki işlem basamaklarını dikkate alarak hayalî bir ürün için pencereli ve 
separatörlü ambalaj maketi hazırlayınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve gü-

venliği tedbirlerini alarak özenle hazırlayınız.
2.	 Öğretmeninizle birlikte hayalî bir ürün belirleyiniz, bu ürüne uygun kutu ambalaj oluş-

turmak için arkadaşlarınızla fikir alışverişinde bulunarak eskiz çizimleri yapınız.
3.	 Eskiz çalışmalarından birini öğretmeninizle birlikte seçerek çiziniz.
4.	 Zamanınızı verimli kullanmaya, sabırlı ve özenli çalışmaya dikkat ediniz.
5.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş şekli sağlığınız için 

zararlıdır.
6.	 Maketin oluşturulacağı yüzeyi sabitleyerek malzemenin kaymamasına dikkat 

ediniz.
7.	 Maketin açılımını yüzeye çiziniz.
8.	 Maketin kesim ve kırım yerlerini yüzeye çiziniz. 
9.	 Ambalaj açılımının çizimini bitirdikten sonra çiziminizi inceleyiniz.
10.	Yüzeyi kesim çizgilerini takip ederek kesiniz.
11.	 Düz kenarlar için maket bıçağı, oval kenarlar için makas tercih ediniz.
12.	Kırım yerlerini keskin olmayan sert bir cisimle iz bırakacak şekilde belirleyiniz.
13.	Yapıştırıcıyı taşırmadan kullanmaya dikkat ediniz.
14.	Yapıştırma kulaklarından birleştirip makete son hâlini veriniz. Üç boyutlu kutu 

ambalajınızı oluşturarak öğretmeninize teslim ediniz.
15.	Çalışmanız bittikten sonra çalışma alanınızı temizleyiniz.

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışmanız, 
Ek 1’de verilen “Ambalaj Maketi Hazırlama Değerlendirme Formu” veya “Ambalaj 
Maketi Hazırlama Kontrol Listesi”ndeki ölçütlere göre değerlendirilecektir. Çalışma-
nızı yaparken bu ölçütleri dikkate alınız.

ÖĞRENME BİRİMİ: AMBALAJ MAKETİ HAZIRLAMA
UYGULAMA ADI   : Kutu Ambalaj Eskizi Hazırlama
AMAÇ                    : Ambalaj tasarımı için maket hazırlama.

Araç Gereç
1.	 Kalın gramajlı resim kâğıdı
2.	 Çizim kalemi
3.	 Silgi
4.	 Cetvel
5.	 Makas, maket bıçağı
6.	 Yapıştırıcı

4. 
Uy

gu
lam

a



129

Ta
nı

tım
 G

ra
fi

ği

AMBALAJ MAKETİ HAZIRLAMA

ÖLÇME VE DEĞERLENDİRME 
A)  Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise 	
      “Y” yazınız. 
1.	 (     ) Ürün ambalajı, nakliye ücretini ve ürün fiyatını gereğinden fazla etkileyecek maliyette 

olmalıdır.
2.	 (     ) Satış ambalajı, doğrudan hedef kitleye ulaşan ambalajdır.
3.	 (     ) Taze meyve, sebze satışında plastik ambalaj kullanılır.
4.	 (     ) Metal ambalajlar sert şartlarda ürünü korur. 

B)   Aşağıda verilen cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.
5.	 Ambalaj çeşitlerinden ………………………….  sağlığa zararlı olduğu için dezavantajlıdır.      
6.	 Isı ya da basınç etkisiyle yumuşatılıp kalıba dökme işlemi ile ……………………………… 

ambalajlara farklı şekiller verilebilir.
7.	 Kâğıt ambalaj şekillerinden biri de …………………………….. ambalajdır.
8.	 Silis  kumunun çeşitli katkı maddeleri ile yüksek sıcaklıkta eritilmesiyle ……………………

ambalalar oluşturulur.
9.	 Ambalaj tasarımı sade ve …………………...... olmalıdır.
10.	Ambalaj tasarımını etkileyen unsurlardan biri de …………………………………dır.

C)   Aşağıda verilen soruların doğru cevaplarını işaretleyiniz. 
11.	 Aşağıdakilerden hangisi katlama işleminin düzgün ve kolay yapılabilmesi için ambalaj 

açılımında belirlenen yerlerden ezme işlemidir? 
	 A)	 Kilit sistemi
	 B)	 Pencere
	 C)	 Perforaj
	 D)	 Pilyaj 
	 E)	 Separatör     
12.	Aşağıdakilerden hangisi ürün ambalaja yerleştirildikten sonra kapağın rahat açılıp 

kapanması için gerekli olan bölümdür? 
	 A)	 Barkod alanı 
	 B)	 Görsel tasarım
	 C)	 Kilit sistemi 
	 D)	 Pencere 
	 E)	 Yapıştırma payı 

D)   Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız. 
13.	 Pencereli kutunun tercih edilme nedenlerini yazınız? 
	 ..................................................................................................................................................................
	 ..................................................................................................................................................................

14.	 Separatör nedir? Açıklayınız.
	 ..................................................................................................................................................................
	 ..................................................................................................................................................................

15.	 Ambalaj tasarımında sektör analizi neden önemlidir? Açıklayınız.
	 ..................................................................................................................................................................	
	 ..................................................................................................................................................................

	





KONULAR
5.1.	 AMBALAJ ESKİZİ 
5.2.	 BİLGİSAYARDA AMBALAJ TASARIMI

NELER ÖĞRENECEKSİNİZ?
•	 Ambalaj üzeri düzenleme ögeleri
•	 Ambalaj tasarımında dikkat edilecek noktalar
•	 Hazırlanan eskize yönlerine dikkat ederek ögeleri 

yerleştirme
•	 Ambalajın açık hâlini çizme
•	 Bıçak, kesim ve kırım yerlerini belirleme
•	 Pencere veya ayracın yer ve ölçüsünü belirleme
•	 Deneme baskısı alarak üç boyutlu maket hazırlama

TEMEL KAVRAMLAR
•	 ambalaj eskizi
•	 bilgisayarda ambalaj tasarımı
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5.1. AMBALAJ ESKİZİ
Gelişen görüntü işleme ve tasarım programları, 
görsel iletişimin önem kazanmasını sağlamış; 
insan algısını ve davranışlarını da etkilemeye 
başlamıştır. Günümüzde iletişim, yazıdan çok 
görsel izleme ile gerçekleşmektedir.

Ürünün piyasada tutulması; doğru ve etkili am-
balajın seçimine, tasarımına bağlıdır. Kolaylıkla 
algılanabilmesi için ürünün markası, barkodu, 
uyarı işaretleri, tanımı ve çeşidi gibi bilgiler am-
balaj üzeri grafik tasarımın görsel kısmını oluş-
turur. Burada amaç, ürünün hedeflenen kitle 
için çekici olması ve satışının sağlanmasıdır. 
Ambalajın değişmeyen ögeleri; marka logosu, 
içerik bilgisi, son kullanma tarihi, üretici firma 
bilgileri ve barkottur.

5.1.1. Ambalaj Üzeri Düzenleme              	
          Ögeleri
Marka: Paketin üzerinde kullanılan marka ismi; 
markayı tanımlama, hatırlatma ve ürün bilgisi 
vermekle sorumludur. Ürünün bulunduğu anda 
ve gelecekte tutulması, aranması için marka 
isminin biçimsel bir özellik kazanması gerekir. 
Özgün tasarlanmış marka kimliği tüketicilerin 
zihninde yer eder. Marka; amblem, logo ve lo-
gotype olarak kullanılabilir. Amaç, akılda kalıcı-
lık ve ürün özellikleriyle örtüşme olmalıdır. 

Hazırlık Çalışmaları
1.	 Satın aldığınız bir ürünün ambalajında genelde nelere dikkat edersiniz?
2.	 Satın aldığınız ürünler arasında en çok beğendiğiniz ambalajın özellikle-

rini arkadaşlarınızla paylaşınız.

Görsel 5.1: Amblem, logo, logotype örnekleri
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Metin: Metinler ürünü tanımlayan ve ürün hakkında çeşitli bilgiler veren kısmı oluşturur. Metin, 
ürün hakkında belirli bilgileri vermelidir. Paketin boyutlarına bağlı olarak farklı puntolarda yazılabi-
lir. Ambalajlardaki metinler birkaç saniyede tüketiciye gerekli bilgiyi vermelidir. Ambalaj içinde ne 
tür bir ürün olduğu, ürünün özellikleri ambalaj üzeri tasarımla müşteriye sunulur. Bunlar ilgi çekici 
olmazsa ürünün satışını etkileyebilir. Bu nedenle sözcüklerin biçimlenmesi, düzenlenmesi profes-
yonelce tasarlanmalıdır. Ambalajı yapacak grafikçinin tipografi bilgisinin olması gerekir.

Ambalaj üzerinde marka tanımını, ürün tanıtımı ve özelliklerini aktaran metinler dışında kanuni 
zorunluluk taşıyan metin bölümleri vardır.

•	 Satın alınan ürünün ambalajına göre tutuş yönüne, açılması, hazırlanması ve saklanma-
sına ait bilgiler

•	 Yiyecek ve içecek türü ambalajlarda tüketiciyi beslenme konusunda aydınlatan bilgiler ve 
ürünün besin değerlerini açıklayan metinler

•	 İlaç kutularında ilacın kullanım şekli ve etkilerinin, uyarıları ve doz ayarlamalarının olduğu 
metinler

•	 Kimyasal ürünlerde ürünün taşınma şekli, saklanma koşulları ve uyarılarla ilgili metinler
•	 Ürün içeriği, gramajı, net ağırlık bilgileri ve adedi ile ilgili metinler

Renkler: Ambalajda kullanılan fon rengi, fonun bir kısmına hâkim olan renk, ürünün  çeşidine 
dikkat çeken renk veya fotoğraf ve illüstrasyonda kullanılan renkler ürünün sunumunda önem arz 
eder. Bu nedenle tasarımcının renk bilgisi olmalı, tasarımcı renklerin psikolojik etkilerini bilmelidir.
Rengin daha işlevsel bir boyutu, ürün kategorisi ve farklılaşmasında kullanılmasıdır. Tüketiciler 
bazı renklerin verdiği mesaja o kadar alışmıştır ki belli ürün gruplarının, bazı tatların, cinsiyetin, 
kalitenin belirlemesinde hep bu renkler kullanılır. Bunun en güzel örneği, kozmetik ürünlerinde 
erkekler ve kadınlar için farklı renk seçeneklerinin kullanılmasıdır.      

Yüzeydeki tek renk veya bir rengin tonlarının egemenliği görsel etkiyi güçlendirir. Ambalajdaki 
yazı ve biçimler, zemin rengiyle karışmamalıdır. Renk kullanımının en doğru şekli, ambalajın 
içindeki ürünü temsil etmesidir. Örneğin renkli boya kalemleri, kozmetik ürünler, matbaa mürek-
kepleri ve boyaların yüzeyinin bir kısmı ürünün içindeki renklerle bağlantılı kullanılır. Ayrıca ekran 
renginin baskıda farklı bir renk olacağı unutulmamalıdır. Baskı alınacak makinanın renk değerleri, 
doğru analiz edilmeli ve tasarım yapılan bilgisayarın renk ayarları ile uyum içinde olmalıdır. 
Sonuç olarak baskıda hangi renkle karşılaşılacağı iyi bilinmelidir.

Görsel 5.2: Açıklama metinleri, barkod
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Görsel 5.3: Ambalajda renk kullanımı
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Görseller: Ürün hakkında bilgi vermenin en etkili yolu, ambalaj üzerinde fotoğraf veya illüstras-
yon kullanılmasıdır. Ambalaj üzeri görsellerin kullanım amaçları şunlardır:	                                                                     

•	 Ürün farklılıklarını belirtmek veya kullanım önerisi yapmak
•	 Ürünün işlevini göstermek, modüler bir ürünün kurulum aşamalarını göstermek, bir ya-

pıştırma malzemesinin kullanımını veya bir yiyecek ürününün hazırlanmasını tarif etmek
•	 Duygusal bir çekim sağlamak
•	 Ambalajın içindeki ürünün son hâlini göstermek 

Fotoğraf ve illüstrasyon, belirli bir beceri ve disiplin gerektiren alanlardır. Bunları farklı şekillerde 
kullanarak insanlar üzerinde değişik duygu ve düşünceler oluşturmak mümkündür. Fotoğraf ya 
da illüstrasyon seçimi tasarımcının kendi kararıdır. Bu tercih; konu, ürün görseli, ürün ölçekleri, 
amaçlanan mesaj, maliyet, baskı tekniği ve tasarımın süresi gibi değişik şartlardan etkilenir.

Görsel 5.4: Ambalaj üzerinde kullanılan görsel örnekleri
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Semboller: Bir kavramı temsil eden somut bir şekil, nesne, işaret, söz ya da bir hareket olarak 
açıklanabilir. Semboller kullanılarak yapılan iletişim, diğer doğrudan iletişim biçimlerine göre çok 
daha farklı, derin ve algılama seviyelerine göre daha yüksektir (Görsel 5.5). Ürün ambalajları, 
kelimeler ve renklerle olduğu kadar sembolik anlatımlarla da tüketiciler ile iletişim kurar. Günümüz 
tüketici eğilimleri çerçevesinde görsel iletişimin önem kazanması, sembollerin kullanılmasına du-
yulan ihtiyacı da artırmaktadır. Semboller, birçok anlamı barındırabilen görsel özellikleri ile bilgi 
alışverişini hızlandırır. Bu doğrultuda günümüzde daha çok ürün ambalajında çeşitli biçimlerde 
görselleştirilmiş sembollerin kullanıldığı görülmektedir.

           

5.1.2. Ambalaj Tasarımında Dikkat Edilecek Noktalar
Günümüzde birçok marka belirli bir ürünü üretmekte ve benzer şekillerde pazarlamaktadır. Ürünün 
tasarımı, satışa ve pazarlamaya doğrudan etki etmekte ve rekabet farkı yaratmaktadır. Bu neden-
le ambalajda grafik tasarımı, satışa sunulan ürünün tüm özelliklerini yansıtmalıdır. Ürünün piyasa-
da tanınabilmesi, bir yer edinerek satış yapabilmesi doğru ve etkili bir ambalaj malzemesinin se-
çimine ve tasarımına bağlıdır. Ürünün yapısına uygun seçilen renkler ve bu renklerle uyumlu yazı 
ve biçimlerle tasarlanan çekici, güzel görünümlü ambalaj müşteriyi etkiler. Ambalaj tasarımı, ürün 
hakkında bilgi verirken ürünün karakterini yansıtır. Ürün, tüketicisine doğrudan ambalaj ile sesle-
nebilir. Dolayısıyla ambalaj bir reklam olarak kabul edilmelidir. Bulunduğu rafın önünden geçen 
tüketiciye birkaç saniyede kutunun içinde ne olduğunu ve kalitesini mesaj olarak iletebilmelidir. 

Görsel 5.5: Ambalaj üzerinde kullanılan semboller 
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Ambalaj tasarımında marka etrafında bir bütünlük oluşturulmalıdır. Zamanla marka ve ambalaj 
bütünleşmeli, akıllarda yer etmelidir. Grafik tasarımcı, ambalaj tasarımında sadece estetik kaygı-
ları değil, şirketin pazarlama politikasını ve kültürel gereklilikleri de göz önünde bulundurmalıdır. 
Satış noktalarındaki ürün diziminde paketin ön yüzü her zaman görünmeyebilir. Bu nedenle am-
balajın yan ve üst yüzeyleri de ürün tanıtımı için önemlidir. 

Ürün ambalajında ürünle tasarım ögeleri arasında sağlam bir ilişki kurulmalıdır. Ambalajın rengi, 
seçilen yazı ve biçimler, bunların düzenlenmesi uyumlu olursa görsel etki güçlü olur. Bu da tüke-
ticinin zihninde olumlu bir imaj yaratır.

Ambalajda renk seçerken  tüketicinin düşünceleri, duyguları, bölgesel ve kültürel algıları göz 
önünde bulundurulmalıdır. Farklı kültürlerde renkler ve kullanılan görseller değişik algılar oluş-
turabilir. Yurt dışı pazarlarına sunulacak ürünlerin ambalajı buna uygun tasarlanmalıdır. Ambalaj 
rengi, ürün yapısı ile bağdaşmalıdır. Bulunması zorunlu yazılar, önem sırasına göre ve ağırlıklı 
olarak görülebilecek yüzeylerde kullanılmalıdır. Karşılıklı yüzeylerde biçim ve yazılar tekrarlana-
bilir. Konserve gibi silindir ambalajlara belirli bir noktadan bakıldığında ambalajın sadece üçte biri 
görülebilir ve dörtte biri okunabilir durumdadır. Yassı ambalajlarda alt kısımlar, fazla önemli olma-
yan bilgiler veya ürünü aldıktan sonra okunacak konular için kullanılır. Ambalajın üst kısmında 
marka, şirket ismi, ayırt edici özellikler gibi asıl bilgiler yer almalıdır.

Farklı ülkelerde farklı görsel algılar olabilir. Bunlar tarihî ve kültürel birikimlerin sonucudur. Bu 
sebeple satışı uluslararası yapılacak bir ürünün ambalaj tasarımlarında bölgeye göre değişiklikler 
olmalıdır. Avrupalı tüketiciler belirgin olarak daha özelleşmiş tercihlere sahiptir. Avrupalılar paketin 
içindeki ürün ile ilgili daha fazla bilgi edinmek ister. Ürünün içeriği ile ilgili açıklamada ve kullanım 
talimatında kesin bilgilerin bulunmasını istenir. Aynı zamanda ambalajların daha dayanıklı olması 
ve ikinci kullanım şansının olması genel olarak çok tercih edilir. Estetik tasarımlara önem verilir. 
Farklı ülkelerde tercihler değişebilir. Tüketiciler dayanıklı ambalaja fazla para ödemek istemeye-
bilir, ucuz ve dayanıklı olmayan ambalajlar tercih edilebilir. Genel olarak çok uluslu bir firma, ulus-
lararası pazarlarda ambalajını kültürel farklılıklara dayanan algılamalara yönelik tasarlayabilir.

Özellikle uluslararası pazarlarda kabul edilemeyecek anlamlara sahip sembollerden kaçınmak 
gerekir. Yazı çevirilerinde dikkatli olunmalıdır, çeviri sırasında oluşabilecek anlam kaymalarından 
sakınılmalıdır. Sembol gibi ambalajın rengi de dikkatle seçilmelidir. Kültürler arasında renklerin 
psikolojik etkileri farklılık gösterebilir. 

5.1.3. Ambalaj Eskizi Hazırlama ve Eskize Ögeleri Yerleştirme
Ambalajın satış aracı olarak verimliliğe katkı sağlayan işlevleri vardır. Ürünü korumakla ve nak-
liyesini, dağıtımını, teşhirini daha kolay hâle getirmekle kalmaz; ürünün pazarlanması için kritik 
fonksiyonları da yerine getirir. Ürünün rakip ürünler arasından sıyrılmasına yardım eder. Ürünün 
tüketici tarafından tanınmasını sağlayacak marka ve ürün kimliğini oluşturur. Ürünü cazip ve dik-
kat çekici şekilde sunar. Ürün hakkında tanımlayıcı bilgileri ve özellikleri gösterir. Ürün çeşidini, 
ebatlarını, farklı tatları ve diğer özellikleri aktarır. Ambalaj; açılması, kapanması, taşınması, sak-
lanması ve tüketilmesi gibi yönlerden ürünü kolay bir biçimde sunar.
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Yapısal tasarım, tüketicinin duygularına hitap eden görseller yaratırken grafik tasarım, ürünün 
satın alınmasını etkilemek için fırsatlar yaratır. Bunu sağlamak için ambalaj grafiği, ürünün tüm 
özelliklerini en güçlü ve anlaşılır şekilde ifade etmelidir. Ambalajda kullanılacak görsel, hem tasa-
rımcıya hem ürün sahibine hem de tüketiciye hitap edebilmelidir.

Ambalaj hazırlarken bazı soruların cevapları düşünülmelidir: 
•	 Aynı ürünü satan başka şirketlerin ürünlerinden tüketicinin bakışı nasıl çekilebilir? 
•	 Tasarımı yapılan ambalaj nasıl farklı ve özgün olabilir? 
•	 Ürünün avantajları nasıl kullanılabilir? 
•	 Grafik görselleri, rakip ürünlerin kullanmadığı şekilde nasıl kullanılabilir?

Ambalaj üzerinde bulunması istenen genel veriler şunlardır: 
•	 Marka kimliği
•	 Ürün adı
•	 Ürünün tanımı
•	 Tat ve çeşit özellikleri
•	 Fayda cümlesi 
•	 Satış metni 
•	 Promosyon mesajı 
•	 Kullanım tarifi 
•	 Başka ürün veya çeşitlere atıf 
•	 Yiyecek ürünlerinde beslenme değerleri 
•	 İlaç ve kimyasal ürünlerde uyarılar 
•	 Ebat ve içerik 

Bunların dışında tasarımcı sonu olmayan grafik ve yazı ile tasarımını yapabilir (Görsel 5.6).

Görsel 5.6: Ambalaj üzerinde kullanılan ögeler  

Logo İçindekiler

Besin değeri

Vitamin değeri

Saklama koşulları

Net miktar Barkod

Üretim yeri

Geri dönüşüm
sembolleri
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1. Etkinlik
Görsel 5.7’yi inceleyiniz. Siz de farklı bir gıda 
ürününün ambalajını birleşim yerlerinden 
özenle, yapısını bozmadan açarak resim kâ-
ğıdına çiziniz. Yazı, görsel ve metin alanlarını 
belirleyiniz. Çalışmanızı kuru boya, sulu boya 
veya serbest teknikle renklendiriniz. Yazı ve 
metin kısımlarını ölçü alarak boş bırakınız.

Eskiz Hazırlarken Dikkat Edilmesi Gereken Noktalar
Yeni bir ambalaj hazırlanırken öncelikle benzer ürünlerin am-
balajlarının incelenmesi faydalı olur. Benzer ürünlerden nasıl 
bir farkla ayrılabileceği, benzerinden pahalı veya ucuz olması-
nın nasıl avantaja çevrilebileceği gibi konular üzerinde fikirler 
üretilmelidir. İnternet ve basılı yayınlar incelenmeli, televizyon 
reklamları takip edilmelidir. Ambalaj tasarımı yapılacak ürün 
hakkında veriler toplanmalıdır. “Ürün ne içerir? Özellikleri ne-
dir? Hangi yaş grubuna hitap eder? Uluslararası pazarlarda sa-
tışı yapılacak mı?” sorularına cevap aranmalıdır. Gerekli bilgiler 
toplandıktan sonra taslak çizimler yapılmalıdır. 
Taslak çalışmaları için kullanılacak fotoğraf ya da illüstrasyon-
lar, ürün logosu ile birlikte hazırlanarak renklendirilmelidir. İllüst-
rasyonlar farklı boyama teknikleri ile elde yapılabilir. Daha son-
ra fotoğraflar için görüntü işleme programı; illüstrasyonlar, yazı 
ve diğer çizimler için vektörel tasarım programları tercih edilir. 
Ambalajın şekline karar verildikten sonra açık hâli kâğıda çizi-
lir. Görseller ve diğer elemanlar taslak olarak yerleştirilir. Grafik 
programları yardımıyla hazırlanan taslak, orijinal hâline getirile-
rek kırım ve kesim yerleri belirlenir. Baskıya hazır hâle getirilir.

Görsel 5.7: Ambalaj
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Seçilen konsept ana marka kimliğinin altında bir alt marka logosu kullanımı gerektiriyorsa alt 
markanın ana markayla ve kurum kimliği ile ilişkisi doğru tanımlanmalıdır. Ürün görsellerinin et-
kili kullanılması için kapsamlı bir araştırma yapılması gerekir. Ürün özelliklerini anlatan cümleler, 
başlangıçta yoksa veya değiştirilecekse tasarımda da değişiklik yapılabilir. Bu durumda marka 
ve ürün kimliği, ürün tanımlaması, renkler, ürün sunumları ve diğer elemanlar için tekrar tasarım 
gerekebilir. Planlama bu doğrultuda yapılmalıdır.

Ambalaj tasarımında ambalaj maketinin mutlaka kullanılması gerekir. Tasarımın üç boyutlu duru-
şu, gerçek görüntüyü oluşturur. Maket hazırlamak için farklı malzeme de kullanılabilir. Ambalajda 
kullanılan etiket, genellikle yüzeyin %40’ını oluşturur. Konsept çalışması ve maket uygulamaların-
dan sonra baskı aşamasına geçilebilir. 

Görsel 5.8: Ambalajların farklı tasarımları

Konsept çalışması: Tasarımı yapılacak ürünün tüm çeşitleri için tasarımın düşünülmesidir. Örne-
ğin bir gıda firmasının bisküvi, gofret, çikolata vb. ürünleri için ambalaj tasarımı çalışmasının plan-
lanması konsept çalışması olarak isimlendirilir. Konsept belirleme aşamasında ürünün özellikleri 
ve hangi özelliklerle satışa sunulacağı müşteriden öğrenilmelidir. Ürün yeni mi çıkacak yoksa 
ürün ambalajında yenileme mi yapılacak gibi soruların cevapları, farklı istek ve öneriler, tasarım-
dan önce müşteriden alınmalıdır.
Piyasada var olan bir ürün için hazırlanan çalışmalar iki biçimde tasarlanabilir.
       •	  Mevcut tasarımın devamı niteliğinde olmalıdır.

•	 Tamamen farklı, önceki tasarımdan hiçbir iz taşımayan, yeni bir hedef kitleye yönelen 
çalışma olmalıdır.
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Görsel 5.9:  Ambalajın açık hâli 

Şekil 5.1                                                                                          

2. Etkinlik
Görsel 5.9’u inceleyiniz. Siz de Şekil 5.1’in içine ürün ambalajının açık hâlini 
çizip; yazı, görsel, renk ve metin alanlarını değiştirerek farklı bir tasarım ya-
pınız. Çalışmanızı kuru boya, sulu boya veya serbest teknikle renklendiriniz. 
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Aşağıdaki işlem basamaklarını dikkate alarak, ürün ambalajı belirleyip es-
kizler hazırlayınız. 

İşlem Basamakları

1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 
güvenliği tedbirlerini alarak özenle hazırlayınız.

2.	 Tasarım için bir ürün seçerek ürüne uygun bir ambalaj belirleyiniz.
3.	 Ürün ambalajı için belirlediğiniz malzeme (kâğıt, karton vb.) üzerine cetvel 

yardımıyla ambalajın açılmış hâlini çiziniz.
4.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş şekli sağlığı-

nız için zararlıdır.
5.	 Yazı, görsel ve metin alanlarının yerini ölçerek belirleyiniz. 
6.	 İşlemleri tekrarlayarak farklı eskizler hazırlayınız.
7.	 Eskizlerden birini seçerek kuru boya, sulu boya, renkli kalemlerle ya da 

farklı bir teknikle eskizi renklendiriniz.
8.	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
9.	 Zamanınızı verimli kullanmaya dikkat ediniz.
10.	Metin alanlarını ince uçlu kurşun kalem ya da tükenmez kalemle yazınız.
11.	 Bitirdiğiniz çalışmanızı temiz bir dosyada saklayınız.

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalış-
manız, Ek 1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki 
ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate 
alınız.

ÖĞRENME BİRİMİ: AMBALAJ ÜZERİ DÜZENLEME
UYGULAMA ADI   : Ambalaj Eskizi
AMAÇ                    : Ambalaj üzeri düzenlemeleri için elle eskiz çalışmaları 
                                    yapmak.
Araç Gereç
1.	 Karton, kâğıt vb.
2.	 Çizim kalemi
3.	 Cetvel 
4.	 Silgi
5.	 Kuru boya, sulu boya vb. 

1. U
yg

ula
ma
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5.2. BİLGİSAYARDA AMBALAJ TASARIMI
Ambalaj üzeri tasarımı, eskiz olarak hazırlandıktan sonra vektörel programa aktarılır. Programa 
aktarma işlemi farklı biçimlerde olabilir. Tasarımcı programı kullanma alışkanlıklarına göre değişik 
uygulamalar yapabilir. Değişmemesi gereken kural; ölçülerin hatasız, kesim ve kırım yerlerinin 
doğru belirlenmiş olmasıdır.

Uygulamalardan birinde eskiz çalışmasının fotoğrafı çekilerek fotoğraf programa aktarılır. Fo-
toğraf sayfaya ölçüsüne göre yerleştirilerek layer açılır ve görsel saydamlığı (opacity) %60-%40 
olarak düşürülür ve kilitlenerek üzerinde çalışılmaya başlanır. Ambalaj ölçüsünden büyük bir say-
fa açılır. Cetvel ve grid çizgileri açılarak milimetrik, hatasız olarak dış hat çizimi yapılır. Bunun 
üzerine illüstrasyon veya fotoğraf yerleşimleri yapılarak tasarım sürdürülür. Fotoğrafların düzen-
lenmesi görüntü düzenleme programında yapılır.

Görsel 5.10: Sayfa açma
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5.2.1. Ambalajın Açık Hâlini Vektörel Programda Çizme
Genel olarak önce bıçak kesim ve kırım çizgilerinin olduğu şablon çizimi, sonra tasarım yapılır. 
Vektörel programda şablon ölçüsünde bir sayfa açılır. Bıçak kesimi yapılacak yerler devamlı çizgi; 
kırım yapılacak yerler kısa, kesik noktalı çizgi ile gösterilir.   

Görsel 5.11: Programda ambalajın açık hâlinin çizimi
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Dış hat veya şablon çizimi bitirilince tasarım kısmına geçilir. Önceden hazırlanmış eskizlerden 
seçim yapılır. Çizim, renklendirme, biçim verme araçları ve Degrade, Gradient, Effect seçimleri 
gibi sonsuz seçenekler uygulanarak eskiz görüntüsü oluşturulur. Kullanılacak fotoğraflar, görüntü 
işleme programında düzenlenir ve vektörel programa aktarılır. Metin kısımları yazılır, zemin dolgu 
renkleri verilir.     

Görsel 5.12: Kırım, kesim yerlerinin çizimi
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Görsel 5.13: Programda ambalajın açık hâlinin çizimi

Görsel 5.14: Ambalaj şablonu

5.2.2. Bıçak, Kesim ve Kırım Yerlerini Belirleme
Ambalaj tasarımının sonunda kesim ve kırım yerlerinin belirlenmesi gerekir. Baskı işlemi tamam-
landıktan sonra ambalaj malzemesinin kesim ve kırım işlemlerinin yapılma aşaması gelir. Bu 
işlemlerin yapılabilmesi için özel bıçaklar yaptırılması ve kırım makinasının ayarlanması gerekir. 
Bu nedenle tasarımı yapan kişi kesim ve kırım yerlerini belirler ve ayrı bir şablonda gösterir. 
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5.2.3. Pencere ve Separatör
Bazı ambalaj türlerinde ambalaj içindeki ürün gösterilmek istenir. Bu nedenle ambalajın bir kısmı 
saydam malzeme ile yapılabileceği gibi o alan için boşluk da tasarlanabilir. Pencere uygulana-
caksa bunun tasarıma ve kesim, kırım şablonuna eklenmesi gerekir. Açma veya ayırma işlemi bir 
diğer şekilde delikli olarak hazırlanır. Bu şekil; bilet, fatura gibi kopartılarak ayrılacak ürünlerde daha 
çok kullanılan bir tasarımdır. Bu işleme perforaj denir. Perforaj makinesi, kesme ve kırım makine-
sinden ayrı bir işlem yapar. Perforaj çizgilerinin şablonda gösterilmesi ve tasarım planında bulundu-
rulması gerekir. Aksi hâlde delikli kısımlar tasarımda çirkin görüntülere sebep olabilir. Separatörler; 
ambalajla ürün arasına yerleştirilen, çarpma ve düşmelere karşı ürünün zarar görmesini engelle-
yen bölümdür. Ürünün hassasiyet özelliklerine göre tercih edildiği için her ambalajda kullanılmaz. 

Görsel 5.15: Pencereli ambalaj 
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5.2.4. Deneme Baskısı ve Ambalajı Oluşturma
Taslak hazırlandıktan sonra varsa gerekli inceleme ve düzeltmeler yapılır, taslağa son şekli verilir. 
Ambalajın yapısal tasarımı tamamlandığında baskıya hazır hâle getirilmesi için ambalaj bilgisayar 
ortamına aktarılır. Öncelik yapısal tasarım olmalıdır, ambalaj üzeri tasarım daha sonra gelmeli-
dir. Yapısal tasarımda görsel unsurlara yer verilmez. Bu aynı zamanda ambalajın kesim, kırım, 
perforaj vb. özelliklerini gösteren bıçak kalıbı özelliğini de taşır. Yapısal tasarım baskı sonrasında 
ambajın kesimi için bıçak yapımında kullanılır.

Yapısal tasarımı tamamlanan ambalajın grafiksel tasarımına geçilir. Grafik her bir yüzey ölçüsüne 
göre ayrı ayrı tasarlanabileceği gibi bütün olarak da tasarlanabilir. Görsel unsurlar yerleştirilirken 
fotoğraf veya illüstrasyonun kırım yerlerine denk gelmemesi gerekir. Tasarım planı dâhilinde fo-
toğraf veya illüstrasyon kırım yerlerine denk gelecekse çirkin bir görüntü oluşturup oluşturmaya-
cağı deneme baskısında takip edilmelidir. Ayrıca çalışmaya taşma paylarının mutlaka verilmesi 
gerekir. Taşma payı ambalajın büyüklüğüne göre değişiklik gösterebilir, standart uygulama 4 mm 
olabilir. Taşma payının verilmemesi hâlinde ambalajın kenar kısımlarında istenmeyen beyazlıklar 
kalabilir (Görsel 5.16). 

Görsel 5.16: Deneme baskısı  
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Görsel 5.17

5.2.5.  Ambalaj Çalışma Örnekleri
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Görsel 5.18
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3. Etkinlik
Görsel 5.19’daki ambalajlar ile ilgili aşağıda verilen soruların cevaplarını 
noktalı yerlere yazınız.
1.	 Ambalajlar farklı renk ve görsellerle tasarlanmıştır. Size göre seçilen renkler 

ürün için uygun mu? Neden?

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………
2.	 Ambalaj tasarımı ürün hakkında gerekli bilgiyi veriyor mu? 

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………
3.	 Ambalajları siz tasarlıyor olsaydınız hangi renkleri kullanırdınız? Neden? 

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………
4.	 Tasarım ögelerinin yerleşimini değerlendiriniz.

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………

	 ………………………………………………………………………………….….

Görsel 5.19: Farklı ambalaj tasarımları 
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Aşağıdaki işlem basamaklarını dikkate alarak, elle yapılan eskizlerden 
uygun olanı bilgisayara aktarıp ambalaj üzerinde  düzenlemeler yapınız. 

İşlem Basamakları

1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı 
ve güvenliği tedbirlerini alarak özenle hazırlayınız.

2.	 Vektörel programda ambalaj boyutlarında bir sayfa açınız.
3.	 Ambalaj maketinin açılmış hâlinin dış çizgilerini milimetrik ölçülerine dikkat 

ederek çiziniz.
4.	 Kırım, kesim ve perforaj yerlerini çiziniz.
5.	 Çalışırken bilgisayar ekranına 20-30 cm mesafeden fazla yaklaşmamaya 

ve sandalyede dik oturmaya dikkat ediniz. 
6.	 Seçilen eskiz doğrultusunda çizim, renklendirme, biçim verme işlemlerini 

yapınız.
7.	 Tasarımlarınızı yaparken belirli aralıklarla kaydediniz. 
8.	 Kullanılacak illüstrasyon veya fotoğrafları görüntü işleme programında dü-

zenleyerek vektörel programdaki ambalaj tasarımına aktarınız.
9.	 Amblem, logo, ürün adı, slogan vb. ögeleri eskize uygun şekilde yerlerine 

yerleştiriniz.
10.	Ambalajda bulunması zorunlu olan metin kısımlarını yazıp yerlerini ayarla-

yınız.
11.	 Çalışmanıza bir isim vererek kullandığınız vektörel programın kendi for-

matında ve baskıya uygun formatta çalışmanızı kaydediniz, bir klasör 
oluşturarak arşivleyiniz. 

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalış-
manız, Ek 1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki 
ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate 
alınız.

ÖĞRENME BİRİMİ: AMBALAJ ÜZERİ DÜZENLEME
UYGULAMA ADI   : Bilgisayarda Ambalaj Üzeri Düzenleme
AMAÇ                    : Bilgisayarda ambalaj üzeri düzenleme yapmak.

Araç Gereç
1.	 Bilgisayar 
2.	 Vektörel çizim programı 2.

 U
yg

ula
ma
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ÖLÇME VE DEĞERLENDİRME 
A)  Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise 	
      “Y” yazınız.
1.	 (     ) Ürünün piyasada tutulması ambalaj seçimine ve tasarımına bağlıdır.
2.	 (     ) Ambalaj tasarımının değişmeyen ögelerinden biri marka logosudur.
3.	 (     ) Ambalaj tasarımında yalnızca firmanın amblemi kullanılır.
4.	 (     ) Metin alanı ürün hakkında çeşitli bilgiler veren kısımdır. 

B)   Aşağıda verilen cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz. 
5.    Kanuni zorunluluklar kısmı, ambalaj üzerinde  …………………………. bölümünde yer alır.       
6.	 Ambalaj tasarımı yapılırken renklerin   …………………………… bilinmesi gerekir.
7.	 Ambalajın görsel alanında fotoğraf veya ……………………………. kullanılır.

C)   Aşağıda verilen soruların doğru cevaplarını işaretleyiniz.  
8.	    Aşağıdakilerden hangisi ambalaj tasarımı yapılırken kesim çizgilerini gösterir? 
	   A)	 Devamlı
	   B)	 İnce
	   C)	 Kalın 
	   D)	 Kesik
	   E)	 Kesik noktalı    
9.	   Aşağıdakilerden hangisi ambalaj açılmadan ürünün görülebilmesi için kullanılan bölümdür? 
  	   A)	 Barkod alanı 
	   B)	 Görsel tasarım
	   C)	 Metin alanı
	   D)	 Pencere 
	   E)	 Yapıştırma payı 

D)   Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.
10.	 Deneme baskısı neden yapılmalıdır? Açıklayınız. 

	 ..................................................................................................................................................................

	 ..................................................................................................................................................................

11.	 Ambalajın vektörel programda çizim aşamalarını yazınız.
	 ..................................................................................................................................................................

	 ..................................................................................................................................................................

12.	 Konsept çalışması nedir? Açıklayınız.
	 ..................................................................................................................................................................

	 ..................................................................................................................................................................

	





KONULAR
6.1.	 TAM (DÜZ) RAPORT SİSTEMİ
6.2.	 YARIM (SOTER) RAPORT SİSTEMİ

NELER ÖĞRENECEKSİNİZ?
•	 Raportlama ile ilgili kavramlar
•	 Tam (düz) raportlama sistemine uygun motif hazırlama
•	 Yarım (soter) sistemine uygun motif hazırlama

TEMEL KAVRAMLAR
•	 raportlama
•	 birim motif
•	 aks
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6.1. TAM (DÜZ) RAPORT SİSTEMİ
Desen motiflerinin enine, boyuna ve eşit aralıklarla tekrar eden en küçük parçasına raport denir. 
Motiflerin yakınlık, uzaklık, büyüklük, renk, gruplanma gibi özelliklerinin farklı şekillerde düzen-
lenmesi işlemine ise raportlama denir. Grafik alanında raportlama, ürünlerin toplu hâlde paket-
lenmeleri esnasında kullanılan ambalaj kâğıtlarında, ambalaj kutusu zemin düzenlemelerinde, 
kaplama malzemelerinde ve sıklıkla tekstil ürünlerinde kullanılır. Raportlama yapılırken basılacak 
yüzeye, bu yüzey malzemesine uygun basım yapacak makinenin özelliklerine ve yüzeyin formuna 
dikkat edilmelidir. Örneğin tekstil ürünlerinde makinenin renk sayısına ve yüzeyin formuna uygun 
hesaplamalar ile tasarımlar yapılmazsa hatalar oluşur.

Sıklıkla kullanılan raport çeşitleri, tam (düz) ve yarım (soter) raporttur. Bunlar dışında diyagonal 
raport, çevirme raport ve kapaklama raport sistemi de bulunur. 

Hazırlık Çalışması

Herhangi bir yüzey üzerinde tekrar eden amblem, logo veya desen motifi dik-
katinizi çekti mi? Örnekler veriniz.

Görsel 6.1: Raportlama 
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6.1.1. Tam (Düz) Raport Sisteminin Uygulama Aşamaları
Amblem, logo veya desenden oluşan birim motifin, enine ve boyuna sıralanması ile oluşturulan 
raport sistemidir. Uygulaması en kolay raportlamadır. Desenlerin tekrarında herhangi bir kaydırma 
yapılmaz ve desenlerin uygun bir şekilde birleşerek yol oluşturması beklenmez. 

Raportlama işlemine başlamadan önce tekrar edecek olan birim desen motifi hazırlanmalıdır. 
Görsel 6.2’de kırmızı çizgiler ile işaretlenmiş dörtlü amblem düzenlemesi, birim motif olarak kulla-
nılmıştır. Motifin; kâğıdın cinsine, kullanım yerine ve baskı yapılacak tekniğe uygunluğuna dikkat 
edilmelidir. Basıma uygun renk modu kullanılarak renklendirilen birim motif, raportlamaya hazır hâle 
gelir. Raportlamaya uygun grafik programında baskısı yapılacak yüzey büyüklüğünde bir doküman 
açılarak işleme başlanır. Ctrl+R kısayolu ya da View > Rulers > Show Rulers komutu ile cetvel 
görünür hâle getirildikten sonra kılavuz çizgileri yardımıyla akslar belirlenir. 

Görsel 6.2: Düz (tam) raport
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Görsel 6.3: Vektörel programda tam (düz) raportlama

Bilgi Kutusu

Vektörel tabanlı programda menü çubuğundan Object > Pattern > Make komutu 
ile desen oluşturularak da raportlama yapılabilir.

1. Etkinlik
Daha önce çalıştığınız bir amblem veya logoyu seçiniz. Vektörel 
tabanlı programda seçtiğiniz ürününe uygun boyutlarda bir dosya 
açınız. Tam (düz) raportlama tekniğine uygun ambalaj kâğıt düzen-
lemesi yapınız. 

Hazırlanan birim motif çoğaltılarak yan yana ve alt alta kılavuz veya aks çizgileri yardımıyla Görsel 
6.3’teki gibi hizalanır. Çoğaltma yapılırken, birden fazla birim motif seçilerek kopyama işlemi 
hızlandırır. 
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ÖĞRENME BİRİMİ: RAPORTLAMA TEKNİKLERİ
UYGULAMA ADI   : Tam (Düz) Raport
AMAÇ                    : Raportlamada kullanılacak deseni tam (düz) raport siste-
                                 mine göre çizmek.

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 Kâğıt
5.	 Kalem
6.	 Cetvel
7.	 Gönye
 

Görsel 6.4:Tam raportlama tekniğine uygun 
ambalaj kâğıdı

Aşağıdaki işlem basamaklarını dikkate alarak raportlama çalışması yapınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 

güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Raportlamada kullanacağınız birim desenin eskizlerini çiziniz.
3.	 Eskizlerden belirlediğiniz bir motifi bilgisayara aktarınız. 
4.	 Vektörel programda 10 x 10 cm ölçülerinde, 300 ppi, renk modu CMYK olan 

bir dosya açınız.
5.	 Dosyayı bilgisayarda uygun yere, vektörel tabanlı programın kendi formatın-

da kaydediniz.
6.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş şekli sağlığınız 

için zararlıdır.
7.	 Vektörel programda birim motifinizi çizip renklendiriniz.
8.	 Vektörel programda A3 boyutlarında, 300 ppi, renk modu CMYK olan yeni bir 

dosya açınız.
9.	 Dosyayı, bilgisayarda daha önce birim motif için dosya açtığınız yere, vektörel 

tabanlı programın kendi formatında kaydediniz.
10.	Cetveli görünür hâle getirerek kılavuz çizgilerinin yerlerini belirleyiniz.
11.	 Gerekli ise kılavuz çizgileri yardımı ile aks çizgilerini oluşturunuz.
12.	Birim motifinizi kopyalayarak çoğaltıp tam (düz) raportlama tekniğine uygun 

düzenlemenizi yapınız.
13.	Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
14.	Oluşturduğunuz kompozisyonu JPEG formatında kaydediniz. 

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışma-
nız, Ek 1’de verilen “Dereceli Puanlama Anahtarı”  veya  ‘‘Kontrol Listesi’’ndeki öl-
çütlere göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

1. U
yg
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ma
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6.2. YARIM (SOTER) RAPORT SİSTEMİ
Raportlama tekniğinde kullanılacak amblem, logo veya desenin; enine veya boyuna 1/2 oranında 
kaydırılması ile oluşan sistemdir. Birim motif, altı akstan oluşur. Tam (düz) raport dört akstan mey-
dana gelirken yarım raportta desenlerin ortasında iki aks daha vardır. Desen, bir yöne doğru tam 
(düz) raportlama sistemine uygun sıralanırken diğer yönde yarım kaydırılarak yüzeye sıralanır.

6.2.1. Yarım (Soter) Raport Sisteminin Uygulama Aşamaları 
Yarım (soter) raport sistemine göre desen hazırlanırken öncelikle amblem, logo ya da desenin öl-
çüleri belirlenir. Tekrar edecek olan birim motif için kılavuzlar yardımıyla akslar oluşturulur (Görsel 
6.6). Desende kaymalar meydana gelmemesi için akslar oluşturulurken hata yapmamaya dikkat 
edilmelidir.

Görsel 6.5: Yarım (soter) raport sitemi

Görsel 6.6: Yarım (soter) raport sisteminde aksların hazırlanması
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Öncelikle amblem, logo ya da desen; kaydırma yapılmayacak şekilde (enine veya boyuna) düz 
raportlamada olduğu gibi sıralanır. Yarım raport sistemi uygulanacak bölümde ise motif, ortalara 
çizilen akslar yardımıyla Görsel 6.7’deki gibi yarısı kadar kaydırılarak sıralanır. 

Yarım (soter) rapolartma yapılırken, raport dışına taşan motiflerde amblem, logo veya desenin 
genel yapısını bozmadan, motif ekleyerek veya çıkararak düzenlemeler yapılabilir (Görsel 6.8).

Görsel 6.7: Yarım (soter) raportlama sistemi

Görsel 6.8: Yarım (soter) raportlama
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Görsel 6.9: Ambalaj raportlama

2. Etkinlik

Daha önce çalıştığınız bir amblem veya logoyu seçiniz. Vektörel tabanlı 
programda seçtiğiniz ürününe uygun boyutlarda bir dosya açınız. Yarım 
(soter) raportlama tekniğine uygun ambalaj kâğıt düzenlemesi yapınız. 
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Raportlama Örnekleri

Görsel 6.10: Tam (düz) raportlama
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Görsel 6.11: Tam (düz) raportlama
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Görsel 6.12: Tam (düz) raportlama
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Görsel 6.13: Yarım (soter) raportlama
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Görsel 6.14: Yarım (soter) raportlama
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Görsel 6.15: Yarım (soter) raportlama
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ÖĞRENME BİRİMİ: RAPORTLAMA TEKNİKLERİ
UYGULAMA ADI   : Yarım (Soter) Raport
AMAÇ                    : Raportlamada kullanılacak deseni yarım (soter) raport sistemine 	
	        göre çizmek. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 Kâğıt
5.	 Kalem
6.	 Cetvel
7.	 Gönye
 

Görsel 6.16: Yarım raportlama tekniğine uygun 
ambalaj kâğıdı 

Aşağıdaki işlem basamaklarını dikkate alarak raportlama çalışması yapınız.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gereçlerinizi, çalışma alanınızı iş sağlığı ve 

güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Raportlamada kullanacağınız birim desenin eskizlerini çiziniz.
3.	 Eskizlerden belirlediğiniz bir motifi bilgisayara aktarınız. 
4.	 Vektörel programda 10 x 10 cm ölçülerinde, 300 ppi, renk modu CMYK olan bir 

dosya açınız.
5.	 Dosyayı bilgisayarda uygun yere, vektörel tabanlı programın kendi formatında 

kaydediniz.
6.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş şekli sağlığınız 

için zararlıdır.
7.	 Vektörel programda birim motifinizi çizip renklendiriniz.
8.	 Vektörel programda A3 boyutlarında, 300 ppi, renk modu CMYK olan yeni bir 

dosya açınız.
9.	 Dosyayı, bilgisayarda daha önce birim motif için dosya açtığınız yere, vektörel 

tabanlı programın kendi formatında kaydediniz.
10.	Cetveli görünür hâle getirerek kılavuz çizgilerinin yerlerini belirleyiniz.
11.	 Gerekli ise kılavuz çizgileri yardımı ile aks çizgilerini oluşturunuz.
12.	Birim motifinizi kopyalayarak çoğaltıp yarım (soter) raportlama tekniğine uy-

gun düzenlemenizi yapınız.
13.	Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
14.	Oluşturduğunuz kompozisyonu JPEG formatında kaydediniz. 

Değerlendirme
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışma-
nız, Ek 1’de verilen “Değerlendirme Formu”  veya  ‘‘Kontrol Listesi’’ndeki ölçütlere 
göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

2.
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ÖLÇME VE DEĞERLENDİRME 
A)   Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış   	
      ise “Y” yazınız.
1.	 (   ) Raportlama; motiflerin yakınlık, uzaklık, büyüklük, renk ve gruplanma gibi özelliklerinin 

farklı şekillerde düzenlenmesi işlemidir.
2.	 (    ) Raportlama yapılırken basılacak yüzey, bu yüzey malzemesine uygun basım yapacak 

makinenin özellikleri ve yüzeyin formu önemsizdir. 
3.	 (   ) Yarım rapolartma yapılırken, raport dışına taşan motiflerde amblem, logo veya desenin 

genel yapısını bozmadan, motif ekleyerek veya çıkararak düzenlemeler yapılabilir.

B)   Aşağıda verilen cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.
4.	 Desen motiflerinin enine, boyuna ve eşit aralıklarla tekrar eden en küçük parçasına ………… 

………denir.
5.	 Amblem, logo veya desenden oluşan birim motifin enine ve boyuna sıralanması ile oluşturu-

lan raport …………………… sistemidir.

C)  Aşağıda verilen soruların doğru cevaplarını işaretleyiniz.  
6.	   Sıklıkla kullanılan raport çeşitleri aşağıdakilerden hangileridir? 
	 A)	 Diyagonal ve çevirme raport
	 B)	 Diyagonal ve yarım raport
	 C)	 Tam ve diyagonal raport
	 D)	 Tam ve yarım raport
	 E)	 Tam, yarım ve diyagonal raport     
7.	   Raportlama tekniğinde kullanılacak amblem, logo veya desenin enine veya boyuna 	
	     1/2 oranında kaydırılması ile oluşan raport sistemi aşağıdakilerden hangisidir?
     	A)	 Tam raport sistemi 
	  B)	 Yarım raport sistemi
	  C)	 Diyagonal raport sistemi
	  D)	 Çevirme raport sistemi
	  E)	 Kapaklama raport sistemi

D)  Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.
8.    Yarım raport sisteminde sıralama enine ve boyuna nasıl yapılır? Açıklayınız.

	 .....................................................................................................................................................

	 .....................................................................................................................................................

9.    Grafik alanında raportlama nerelerde kullanılır?

	 .....................................................................................................................................................

	 .....................................................................................................................................................
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             DEĞERLENDİRME FORMU
Yönerge
Uygulama faaliyeti sonunda öğrenci başarısını aşağıdaki ölçütleri dikkate ala-
rak; 1 (GELİŞTİRİLEBİLİR), 2 (ZAYIF), 3 (ORTA), 4 (İYİ), 5 (ÇOK İYİ) şeklinde 
puanlayayıp form sonundaki değerlendirme yönergesine göre  değerlendiriniz.

ÖLÇÜTLER
DERECELER Alınan

Puan1 2 3 4 5

Giriş
Uygulamaya yönelik araç gereci 
getirmiş.
Konuya ilişkin  ön araştırmalar 
yapmış.
Konu ile  ilgili özgün eskiz 
çalışmaları yapmış.

Tasarım ilkelerini eskiz çalışmalarına  
uygulamış. 

Gelişme
Eskiz çalışmasını uygun bilgisayar 
programına aktarmış.
Bilgisayar  programında uygun menü 
araçlarını kullanmış. 
Çalışmayı  ilgili bilgisayar  
programında amaca uygun olarak 
tamamlamış.

Sonuç
Çalışmayı uygun  dijital formatta 
kaydetmiş.
Çalışmanın istenen özelliklere uygun  
baskısını almış.
Zamanı planlı ve verimli kullanmış.

Çalışmayı temiz ve düzenli  teslim 
etmiş.

Atölye ortamını temiz ve düzenli 
bırakmış.

Toplam Puan
Değerlendirme Tabloda her ölçütten alınabilecek en yüksek puan 12 x 5 = 60’tır.   

PUAN = [(Genel puan toplamı x 100) / Alınabilecek en yüksek 
toplam puan] formülü uygulanarak 100’lük sisteme dönüştürülür.
NOT: Bu puanlama anahtarından 100 üzerinden 70 alırsanız bir 
sonraki konuya geçebilirsiniz. 69 ve altında puan alırsanız ilgili konu 
tekrar edilmelidir.
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KONTROL LİSTESİ
UYGULAMA ADI:..........................................

Yönerge
Aşağıdaki gözlenecek davranışlardan öğrencinin kazanabildiği beceriler için EVET 
kazanamadığı beceriler için HAYIR kutucuğunu (X) işaretleyiniz. 

GÖZLENECEK DAVRANIŞLAR EVET HAYIR

Uygulamaya yönelik araç gereci getirmiş.

Konuya ilişkin  ön araştırmalar yapmış.

Konu ile  ilgili özgün eskiz çalışmaları yapmış.

Tasarım ilkelerini eskiz çalışmalarına  uygulamış. 

Eskiz çalışmasını uygun bilgisayar programına aktarmış.

Bilgisayar  programında uygun menü araçlarını kullanmış. 

Çalışmayı  amacına uygun ilgili bilgisayar  programında 
tamamlamış.

Çalışmayı uygun  dijital formatta kaydetmiş.

Çalışmanın istenen özelliklere uygun  baskısını almış.

Zamanı planlı ve verimli kullanmış.

Çalışmayı temiz ve düzenli olarak teslim etmiş.

Atölye ortamını temiz ve düzenli bırakmış.

Değerlendirme 12 ölçütten toplam 2 ve üstü sayıda HAYIR varsa uygulamada BAŞARISIZ 
olunmuştur. 
Not: Uygulama sonucunu BAŞARISIZ ise, başarısız olduğunuz konulara 
geri dönüp bu konuları tekrar ediniz. BAŞARILI ise, bir sonraki üniteye ge-
çebilirsiniz.
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                  AMBALAJ MAKETİ HAZIRLAMA 

             DEĞERLENDİRME FORMU
Yönerge
Uygulama faaliyeti sonunda öğrenci başarısını aşağıdaki ölçütleri dikkate ala-
rak; 1 (GELİŞTİRİLEBİLİR), 2 (ZAYIF), 3 (ORTA), 4 (İYİ), 5 (ÇOK İYİ) şeklinde 
puanlayıp form sonundaki değerlendirme yönergesine göre  değerlendiriniz.

ÖLÇÜTLER
DERECELER Alınan

Puan1 2 3 4 5

Giriş
Uygulamaya yönelik araç gereci 
getirmiş.

Konuya ilişkin  ön araştırmalar 
yapmış.

Konu ile  ilgili özgün eskiz 
çalışmaları yapmış.

Tasarım ilkelerini eskiz çalışmalarına  
uygulamış. 

Gelişme
Ürüne uygun renk seçimi yapmış.

Maketin açık hâline kırım ve kesim 
yerlerini çizmiş.
Maketin kırım ve kesim işlemini 
uygulamış.
Yapıştırma  işlemini yaparak makete 
son hâlini vermiş.

Sonuç
Zamanı planlı ve verimli kullanmış.

Çalışmayı temiz ve düzenli  teslim 
etmiş.
Atölye ortamını temiz ve düzenli 
bırakmış.

Toplam Puan
Değerlendirme Tabloda her ölçütten alınabilecek en yüksek puan 12 x 5 = 60’tır.   

PUAN = [(Genel puan toplamı x 100) / Alınabilecek en yüksek 
toplam puan] formülü uygulanarak 100’lük sisteme dönüştürülür.
NOT: Bu puanlama anahtarından 100 üzerinden 70 alırsanız bir 
sonraki konuya geçebilirsiniz.  69 ve altında puan alırsanız ilgili 
konu tekrar edilmelidir.
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AMBALAJ MAKETİ HAZIRLAMA
KONTROL LİSTESİ

Yönerge
Aşağıdaki gözlenecek davranışlardan öğrencinin kazanabildiği beceriler için EVET 
kazanamadığı beceriler için HAYIR kutucuğunu (X) işaretleyiniz. 

GÖZLENECEK DAVRANIŞLAR EVET HAYIR

Uygulamaya yönelik araç gereci getirmiş.

Konuya ilişkin  ön araştırmalar yapmış.

Konu ile  ilgili özgün eskiz çalışmaları yapmış.

Tasarım ilkelerini eskiz çalışmalarına  uygulamış. 

Ürüne uygun renk seçimi yapmış.

Maketin açık hâline kırım ve kesim yerlerini çizmiş.

Maketin kırım ve kesim işlemini uygulamış.

Yapıştırma  işlemini yaparak makete son hâlini vermiş.

Zamanı planlı ve verimli kullanmış.

Çalışmayı temiz ve düzenli olarak teslim etmiş.

Atölye ortamını temiz ve düzenli bırakmış.

Değerlendirme 12 ölçütten toplam 2 ve üstü sayıda HAYIR varsa uygulamada BAŞARISIZ 
olunmuştur. 
Not: Uygulama sonucunu BAŞARISIZ ise, başarısız olduğunuz konulara 
geri dönüp bu konuları tekrar ediniz. BAŞARILI ise, bir sonraki üniteye ge-
çebilirsiniz.
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1.	 D
2.	 Y
3.	 D
4.	 D
5.	 D
6.	 duvar
7.	 görsel
8.	 tipografik
9.	 adet
10.	 D
11.	 D
12.	 A
13.	 D
14.	 D
15.	 Kuruma ait özel bir font varsa o kullanılmalıdır, yoksa kuruma uygun olan font seçilmelidir. 

Seçimde takvim çeşidi de göz önünde bulundurularak yazıların okunaklı, anlaşılır ve görü-
lebilir olması dikkate alınmalıdır. 

16.	 Çalışmanın toplam baskı adedine, baskı makinesinin özelliklerine, ciltleme çeşidine, kulla-
nılmak istenen malzeme ve ölçüye göre düzenleme yapılır. 
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1.	 C
1.	 D
2.	 Y
3.	 Y
4.	 D
5.	 Y
6.	 görüntü düzenleme
7.	 büyüklük
8.	 reklam afişleri 
9.	 eskiz
10.	 materyal
11.	 D
12.   A
13.   Sosyal afişler toplumda farkındalık yaratmak, insanların bazı konulara daha duyarlı olma-

larını sağlamak için hazırlanır. Reklam afişleri ise ürün ya da hizmeti tanıtmayı amaçlayan 
satış yapmaya yönelik  afişlerdir.

14.  Başkalaşım tasarımların daha orijinal olması, hedef kitlenin dikkatini çekmesi, akılda kalıcı-
lığın artırılması için yapılır.

CEVAP ANAHTARI
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1.	 D
2.	 Y
3.	 D
4.	 kâğıt ve türevi
5.	 şeffaf etiket
6.	 C
7.	 D
8.	 Plastik bazlı etiketlerin dayanıklılığı kâğıt bazlı etiketlere oranla daha fazladır. Dayanıklı 

olması sayesinde genellikle sanayi, kozmetik ve kimya sektöründe kullanılır. 
9.	 Markanın logosu dikkat çekecek bir şekilde kullanılmalıdır.
	 Yapılacak etiket, ürünün temel bilgilerini ve özelliklerini yansıtmalıdır; yazılar açık ve oku-                

nabilir olmalıdır.
	 Kullanılan görseller ilk izlenimde dikkat çekmeli ve bilgilendirici olmalıdır.
	 Tasarım üzerinde kullanılan renkler dikkat çekmelidir.
	 Seçilen yazı tipi tasarımla uyumlu olmalıdır. 
	 Ürün hakkında verilecek önemli bilgiler en üste büyük puntolarla yazılmalı, diğer bilgi-

ler ise uygun puntolarla sıralanmalıdır. 
	 Yeterli oranda beyaz alan bırakılmalıdır.
	 Firmaya ait iletişim bilgileri açık ve net bir biçimde olmalıdır. 
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1.	 Y
2.	 D
3.	 Y
4.	 D
5.	 alüminyum
6.	 plastik
7.	 viyol
8.	 cam 
9.	 estetik 
10.	 yasal sınırlılıklar 
11.	 D
12.	 C
13.	 Pencereli kutu:  Ürünün görünebilmesi için kullanılan, ayrıca farklı tasarım imkânları su-

nan bölümdür. Kutu ambalajlarda paketi açmadan ürünü tüketicinin görmesine olanak 
sağlar. Pencere için belirlenen alan genellikle ön yüzde bulunur. Kutu içindeki ürünün 
kutudan çıkmasını önlemek için genellikle saydam bir malzeme ile kapatılır.

14.	 Separatör: Ambalaj ile ürün arasına yerleştirilen karton, oluklu mukavva, strafor ya da 
hava yastığına separatör denir. Çarpmalara, düşmelere karşı ürünün zarar görmesini ön-
lemek için separatör kullanılır. 

15.   Sektör analizinde detaylı araştırmalar yapılarak elde edilen veriler dosyalanmalıdır. Bir 
üründen her açıdan maksimum fayda sağlamak adına ambalaj, bu veri dosyasındaki 
bilgiler doğrultusunda tasarlanmalıdır. Sektör analizinde araştırılması gerekenler şunlar-
dır:

•	 Ürün ile ilgili mevcut bütün özellikler ve benzerlerinden ayrılan özellikler
•	 Hedef kitle ile ilgili demografik özellikler başta olmak üzere üründen beklenenler
•	 Pazar ile ilgili pazar olarak kabul edilecek bölge başta olmak üzere ürün ile aynı ve benzer 

olan ürünlerin pazar payları ve satış ciroları
•	 Üretici firmanın kısa ve uzun vadede üründen net beklentileri
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CEVAP ANAHTARI
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1.	 D
2.	 D
3.	 Y
4.	 D
5.	 metin alanı 
6.	 psikolojik etkilerinin 
7.	 illüstrasyon
8.	 A
9.	 D
10.	 Yapısal tasarımı tamamlanan ambalajın grafiksel tasarımına geçilir. Her bir yüzey ölçü-

süne göre ayrı ayrı tasarlanabileceği gibi bütün olarak da tasarlanabilir. Görsel unsurları 
yerleştirirken fotoğraf ve ya illüstrasyonun kırım yerlerine denk gelmemesi gerekir.  Tasarım 
planı dâhilinde fotoğraf veya illüstrasyon kırım yerlerine denk gelecekse çirkin bir görüntü 
oluşturup oluşturmayacağı deneme baskısında takip edilmelidir.

11.	 Önce bıçak, kesim ve kırım çizgilerinin olduğu şablon çizimi yapılır; sonra tasarım yapılır.
12.	 Tasarımı yapılacak ürünün tüm çeşitleri  için tasarımın düşünülmesi, ambalaj tasarımı ça-

lışmasının planlaması konsept çalışması olarak isimlendirilir.
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1.	 D
2.	 Y
3.	 D
4.	 raport
5.   tam (düz) raport
6.	 D
7.	 A
8.   Desen, bir yöne doğru tam (düz) raportlama sistemine uygun sıralanırken diğer yönde yarım 

kaydırılarak yüzeye sıralanır.
9.	 Grafik alanında raportlama, ürünlerin toplu hâlde paketlenmeleri esnasında kullanılan 

ambalaj kâğıtlarında, ambalaj kutusu zemin düzenlemelerinde, kaplama malzemelerinde 
ve sıklıkla tekstil ürünlerinde kullanılır.
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